



Ответы к тестам Seagull







В данном документе даны ответы на все обязательные и рекомендуемые к прохождениею тесты. Вопросы даны со всеми вариантами ответов, правильные выделены цветом.
Для прохождения необязтаельно слушать весь тест, а можно лишь запустить его и открывая каждую главу нажимать постоянно стрлеку  вправо:
[image: ]
Нажимать её следует до тех пор пока стрелка вправо не пропадет, и не останеться следующее
[image: ]
(ползунок по середине должен полность заполниться белым цветом, пропадает стрелка вправо)
Далее нажимаем “Menu” и переходим к следующей главе.
Так же в главах часто попадаются попадаются вопросы (в конце), на которые отвечать НЕ ОБЯЗАТЕЛЬНО! Если они есть, то стоит выполянять инструкции указанные выше, т.е. только нажимать стрлелку вправо…
Для успешного прохождения теста необходимо чтобы каждая глава была просмотрена на 100% и тест выполнен не менее 75% (а так этот документ содержит все возможные варианты вопросов, то при правильно использовании ответы на тест будет 100%).
При выполнении  теста (“Assesment”), отмечаем правильный ответ(ы) нажимем “Done”. Появляеться стрелка вправо, нажимем её и переходим к следующему вопросу.
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CD # 1 Personal  Safety
Состоит из пяти глав.
1-4 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
5 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























1) What is the intention of the Safety Meeting? 
1. The intention of this meeting is to gather the off duty crew so that they can get  to know each other better, which will affect the safety onboard. 
2. The intention of this meeting is to assign planned work to the crew, and to insure that checklists and permits have been filled in before the work starts. 
3. The intention of this meeting is to inform and train the crew in safety matters and to get the crew to participate in discussions and make their own suggestions for improvements. 
4. The intention of this meeting is to discuss the activities ashore. 

2) Why is it important that you become familiar with the vessel, the equipment and your own duties on board as soon as possible? 
1. It is important for you to know so that you can find your way around without someone guiding you all the time. 
2. In an emergency situation you need to know what to do and the position and use of different safety and fire fighting equipment. 
3. In an emergency situation it is important  to know where to find the Safety Officer for reporting. 
4. It is important to know the port operational procedures for handling cargo. 

3) Combine the correct hazard sources signs and name.      

[image: ]
4) Are you allowed to smoke marijuana when outside U.S water? 
1. Yes, you are allowed to smoke marijuana outside U.S. water 
2. Yes, you are allowed to smoke marijuana if there are at least 4 hours until you go on duty, and you have permission from the master. 
3. No, any use of drugs onboard is strictly prohibited. 
4. Yes, only for medicinal purpose. 



5) Which types of work require permits or check list?(Check all correct answers) 
1. Painting on deck 
2. Chipping on the bridge deck 
3. Painting the mast with help of a bosun's chair 
4. Lowering the anchor 
5. Chipping down in the ballast tank 
6. Welding on the poop deck 
7. Welding in the engine work shop 
8. Dismantling a pump 

6) Which are the most common injuries in general on board? 
1. Toxic injuries 
2. Sprain, cuts or twisting of arms, hands or fingers 
3. Head injuries from falling objects 
4. Foreign body in eyes from welding, dust etc. 
5. Damage to ears caused by loud noises 
6. Burns from steam, hot oil or chemicals 
7. Injuries of back or shoulders caused by poor working posture or wrong lifting techniques. 
8. Sprain or cuts in legs, feet or toes. 

7) Which accidents or injuries are the most common connected to maintenance work? 
1. wet shoes 
2. foreign bodies in eyes 
3. using the needle gun on a foot 
4. injuries from abrasive blasting 
5. injuries from using chemicals 
6. swallowing dust 
7. injuries from falling 
8. falling overboard 

8) Place the correct text right of the pyramid  (Расставляем в таком порядке)
1. Serious or Major Injury
2. Minor Injury
3. Property Damage Accidents
4. Incidents with No Visible Injury or Damage

9) Protection and Environment work consists of which four elements? 
1. Information / Training 
2. Jubilees and celebrations 
3. Protective Equipment 
4. Following up Reports 
5. Seasickness protection 
6. Looking for oil spills 
7. Maintenance 
8. Drug testing the crew 

10) How can you best protect yourself against the most common injury, sprains or cuts in hands, arms or fingers? 
1. By avoiding operations and jobs that can cause such accidents 
2. By using gloves when practical, and being observant of the risk 
3. By never touching anything with your hands and always using some kind of tool 
4. It depends on the work requirement. 

11) In which type of jobs is there a risk of exposure to harmful substances? 
1. Cargo handling 
2. Cleaning 
3. Corrosion protection 
4. Painting 
5. Tank cleaning 
6. Working in the engine room 




















CD # 2 Ship General Safety
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























1) What is the meaning of the term ‘Vessel Risk Factors’ as described in this module?  
1. All factors which represent a risk to the general safety of a ship. 
2. Only factors which represent a risk of failure of a ship’s machinery. 
3. Only factors which represent a risk to the vessels structural strength.  
4. Only factors which represent a risk to the health of a ship’s crew.  
 ﻿ 
2) Select the correct statement: High specific gravity cargo piling up on the tank top may affect the structure of -  
1. the double bottom only.  
2. the double bottom and the side shell.  
3. the double bottom, the side shell and the transverse bulkheads.  
4. the side shell only. 
 ﻿ 
3) What information should be contained in the 'Vessel Enhanced Survey File?' Select all correct options.  
1. the status of the hull structure based on previous records of surveys and reports.  
2. the survey programme of the critical areas of the hull structure, access possibilities and minimum thickness records.   
3. a complete record of the condition of the hull and fittings including details of any previous repairs. 
4. a record of the weather conditions affecting the deck area and superstructures.  
 ﻿ 
4) Who is ultimately responsible for the general condition and maintaining the structural strength of a vessel?  
1. Only the Classification Society Surveyor.   
2. Only the owner 
3. Both the surveyor and the owner 
4. Only the Ship's Master 
 ﻿ 
5) How should ‘significant defects’, identified during an enhanced survey inspection, be dealt with? 
1. By prompt and thorough repair before the vessel can continue trading.  
2. They should be added to the vessels dry-dock repair list.  
3. They should be given a condition of class and checked again at a later date.  
4. They should be repaired at the next convenient opportunity.   
 ﻿ 
6) The overhaul of an auxiliary engine is to be carried out by an experienced engineer assisted by an inexperienced junior engineer. Is it important to follow the instructions given in the Planned Maintenance System manual when work is carried out by an experienced person?  
1. Yes, it is important in order to follow the proper routines and avoid the risk of overlooking some relevant information.  
2. Since an experienced engineer is participating, the use of reference information is not particularly important.   
3. If there is time to use reference information, this can be done. Otherwise it is not particularly important.   
4. The Planned Maintenance System manual needs only to be used by the junior engineer.  
 ﻿ 
7) How do structural corrosion and structural damage affect the risk to the general safety of a vessel? Select all of the correct options.  
1. Increases the risk because the structure is weakened.  
2. Increases the risk since the defects may act as stress raisers.  
3. Increase the risk since still water bending may occur.  
4. They have no affect on the level of risk.  
 ﻿ 
8) The vessel structure is subject to stresses due to various internal and external forces acting upon it. Select, from the options given, the conditions which will result in additional stress due to external forces.    
1. Action of rough seas.  
2. Vessel movement in a seaway.  
3. Operation of ship’s machinery  
4. Stowed cargo.  
 ﻿ 
9) When considering machinery risk factors, in the context of the vessel risk profile as defined in this module, which machinery or systems may be considered to be the most critical? 
1. Any piece of machinery or system which would result in loss of control of the vessel in the event of it failing.  
2. The failure of any piece of machinery or system which would result in the vessel being put 'off hire.'  
3. Only the main propulsion system.  
4. Only the steering gear and electric power plant.  
 ﻿ 
10) Which factors should be considered when putting together a vessel risk profile as described in this module?  
1. All factors which put the vessel’s general safety at risk.  
2. All factors that give a risk of machinery failure.  
3. All factors that give a risk of the cargo being damaged.  
4. All factors which may result in an increased risk of corrosion.  
 ﻿ 
11) What would be the result of loading a vessel without a properly formulated loading plan, particularly at a high loading rate terminal? Select all of the correct options. 
1. Excessive stresses may result due to unusual and unacceptable still water bending.  
2. It may create stress raisers.  
3. It may accelerate corrosion of the hull structure.  
4. It may result in excessive local stresses due to uneven distribution of cargo.  
 ﻿ 
12) How can machinery risk factors which contribute to the vessel risk profile as defined in this module be limited or eliminated?  Select all of the correct options. 
1. Correct and timely maintenance procedures.  
2. Operating all machinery within manufacturer’s limits.  
3. By only operating on good quality distillate fuel 
4. By ensuring that all engineroom personnel are adequately trained.  
 ﻿ 
13) Which vessel types are subject to enhanced survey requirements as part of an Enhanced Survey Programme? 
1. Bulk Carriers and oil tankers.  
2. Only bulk carriers  
3. Only offshore support vessels  
4. Only oil tankers  
 ﻿ 
14) An experienced officer is signing on a new vessel. Immediately upon arrival, he is ordered to take the watch on the bridge without completing a familiarisation programme. Should this be considered acceptable?  
1. No, an officer should always go through an appropriate familiarisation programme before he takes over as the Officer of the Watch.  
2. Yes. He has experience on a bridge and so doesn't need to do familiarisation for every ship.  
3. Yes, if the Officer of the Watch is certified by the Classification Society, he doesn't need a familiarisation programme.   
4. Yes, if the Officer of the Watch is certified by the Flag State authority, he doesn't need a familiarisation programme.  
 ﻿ 
15) Where is information regarding vessel structural standards likely to be found?  Select all of the correct options. 
1. Classification Society rules.  
2. SOLAS.  
3. ISM Manual.  
4. Marpol 73/78  
 ﻿ 
16) Which publication contains the requirements for testing of ship’s steering gears?  
1. SOLAS Chapter V  
2. Marpol 73/78  
3. ISM Code  
4. IMDG Code  
 ﻿ 
17) Which design feature of modern tankers and bulk carriers has resulted in reduced vessel risk factors as well as improved environmental protection?  
1. Double hull construction.  
2. All aft accommodation  
3. All aft machinery spaces.  
4. Bulbous bows  
 ﻿ 
18) Which components are considered to be part of the main propulsion system for a vessel with conventional diesel propulsion?  Select all correct options. 
1. Main engine and gearbox. 
2. Shafting, bearings and propeller.  
3. Electrical power generation and distribution system  
4. Steering gear system 
 ﻿ 
19) Which personnel should be familiar with the emergency electrical power supply arrangements and change over procedures?  
1. All engineroom personnel.  
2. Only the Chief Engineer.  
3. Only the ship’s Electrical Officers.  
4. Only the watchkeeping engineers.  
 ﻿ 
20) Why is there a greater risk of serious fire hazard in the engine room than anywhere else on the ship?  Select all correct options. 
1. Multiple potential heat and ignition sources. 
2. Fuel and other combustible material generally present. 
3. Smoking is generally permitted in the engineroom.  
4. Engine rooms are always dirty and oily.  
 ﻿ 
21) Which of the following activities is classed as condition monitoring in respect to engineroom operations? Select all of the correct options.  
1. Vibration analysis. 
2. Used oil analysis  
3. Maintenance based on running hours or service time.  
4. Maintenance based on breakdown  
 ﻿ 
22) Which of the following elements are considered necessary for safe and effective voyage planning? Select all of the correct options.  
1. Full appraisal of all information and conditions.  
2. Planning the voyage from berth to berth in full detail.  
3. Executing the plan.  
4. Continuous monitoring of the plan with regular review of voyage progress and conditions.  
 ﻿ 
23) Once a voyage plan is formulated who should sign it to confirm acknowledgement that it is acceptable?  
1. All bridge team personnel.  
2. Only the Master.  
3. Only the Navigating Officer.  
4. Only the Chief officer.  
 ﻿ 
24) Which of the following should be included in a voyage plan? Select all of the correct options.  
1. Up to date charts showing intended track and any areas of danger or any hazards. 
2. Indication of safe speed and any speed changes that may be necessary. 
3. Any course alteration points. 
4. The methods to be used for position fixing. 
 ﻿ 

25) he GMDSS equipment is considered essential to the ship’s general safety. Which of the given options either individually or in combination, is considered an acceptable arrangement under SOLAS requirements for maintenance of the equipment?  Select all of the correct options. 
1. There must be a trained maintainer on board.  
2. There must be duplication of the equipment necessary for emergency and distress signals.  
3. The ship must have a shorebased maintenance contract.  
4. The maintenance can be carried out by any of the ship’s engineers.  
 ﻿ 
26) How has the incidence of collision and grounding in congested waterways been significantly reduced?   
1. Introduction of traffic separation schemes.  
2. Introduction of double hull vessels.  
3. Introduction of special areas in Marpol regulations.  
4. Introduction of marine fuel sulphur limits 




















CD # 4 SOPEP
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























1) What does the abbreviation SOPEP mean? 
1. Shipboard Oil Pollution Emergency Plan 
2. Shipboard Oil Pollution Emergency Procedures 
3. Safety and Oil Pollution Emergency Procedures 
4. Safety and Oil Pollution Emergency Plans 

2) ﻿Which statement is true? 
1. Every vessels of more than 400 gross tons must carry a SOPEP manual. 
2. Every oil tanker above 150 gross tons and every ship above 400 gross tons must carry a SOPEP manual. 
3. Vessels carrying an IOPP Certificate do not need a SOPEP Manual. 
4. Every vessel of more than 400 gross tons must carry a SOPEP manual in the United States waters. 

3) ﻿Are OPA 90 and SOPEP applicable for the same type of vessels? 
1. Yes, but OPA 90 is only applicable to the U.S. coast while SOPEP is applicable in all waters. 
2. No, OPA 90 is also applicable to dry cargo vessels and all other vessels. 
3. No, OPA 90 is only mandatory for vessels of more than 500 gross tons. 
4. No, OPA 90 is only mandatory for tanker vessels. 

4) ﻿What is a Risk Profile? 
1. The Risk Profile is the total amount of risk factors related to your vessel. 
2. A Risk Profile is a risk factor related to your vessel during an oil spill. 
3. A Risk Profile is the vessel’s risk factors of any oil spill that may occur. 
4. A Risk Profile is a document that must be part of an oil spill initial report 

5) ﻿What are the two most important parties to be notified in case of an oil spill in US waters? 
1. US Coast Guard National Response Center and the cleaning-up contractors. 
2. US Coast Guard National Response Center and the company representative in US. 
3. Cleaning-up contractors and company representative in US. 
4. US Coast Guard National Response Center and the company head office. 

6) ﻿What agreement is to be entered into between a vessel and a salvage company in an emergency? 
1. Vessel Response Plan (VRP) 
2. Vessel Emergency Form (VEF) 
3. Lloyds Open Form (LOF) 
4. Salvation Open Document (SOD) 

7) ﻿What is the most important risk factor to be observed relative to contingency? 
1. Lack of ship management training. 
2. Inappropriate training of personnel in preparedness. 
3. Inappropriate training of operating personnel in preparedness of safety equipment. 
4. Lack of ship crew training. 

8) ﻿What is the top priority if an incident occurs in US waters? 
1. Safety of the ship and crew 
2. Protection of the environment 
3. Prevention of oil pollution 
4. Safety of the cargo 





9) ﻿For which of the following categories is it important that predefined tasks have been established? 
1. Senior officers 
2. All officers 
3. Entire crew 
4. Deck personnel 

10) ﻿Is it necessary to carry out 'oil spill drills?' 
1. Yes, but only if trading in US waters 
2. Should be carried out if not resulting in delay or loss of working hours 
3. Yes, they should be carried out frequently 
4. Yes, but not until a non-conformity is established 

11) ﻿Who must contact the news media first? 
1. The Master is to send out a press release as soon as the vessel and crew are safe. 
2. The Company's Managing Director is to issue a press release as soon as he has talked with the Master. 
3. The head of the Company Casualty Group is to send out a press release if the incident is of public interest. 
4. The Master is to send out a press release but only after the approval of the local coast guards 

12) ﻿What do we call situations that could have led to an accident if they had developed further? 
1. Non-conformities 
2. Near misses 
3. Accidents 
4. Risk factor 















CD # 5 ISM Code
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























1) For whom is the ISM-Code mandatory? 
1. All vessels 500 grt and above 
2. All tankers 
3. All vessels built after 1998 
4. All vessels on International routes 

2) Why is the ISM-Code mandatory? 
1. To satisfy US Coast Guard 
2. To improve safety 
3. To save money for the company 
4. To get lower insurance premiums  ﻿

3) The ISM Code is part of? 
1. SOLAS 
2. STCW 
3. MARPOL 
4. High Speed Craft Code     ﻿

4) What does SMS mean? 
1. Shipboard Management System 
2. Safety Manual System 
3. Safety Management System 
4. Shipboard Management Safety 

5) Who can contact the Designated Person? 
1. The shipping company only 
2. The Captain 
3. All Senior Officers 
4. All Officers and Crew   ﻿

6) The Safety Management System requires that the shipping company develops and implements? 
1. A system to report, analyse and follow up non-conformities, accidents and hazardous situations 
2. A system for voyage planning 
3. A system for main engine maintenance 
4. A system for managing unplanned maintenance tasks  ﻿

7) Mark the 4 occasions when you should send a report to the DP (Designated Person). 
1. Your salary is not correct. 
2. There is an overflow in the bunker tank  
3. You can not complete the pre-Departure checklist 
4. You find a better way to do your job, than the way described in your job description 
5. The chief cook’s food is not good 
6. You fall and break your arm in the mess room after duty   ﻿

8) Why should you report accidents to the DP (Designated Person)? 
1. To find some one to blame. 
2. To prevent it from happening again 
3. So the company can calculate your safety bonuses 
4. To be able to receive an insurance claim   ﻿





9) Who can suggest changes to the SMS? 
1. The designated person 
2. The Captain 
3. All Officers and Crew 
4. All Senior Officers    ﻿

10) Drag the correct work permit to the work situation where you need it. 
[image: ]
﻿
11) When are you allowed to throw plastic garbage overboard? 
1. Being more than 25 miles from shore. 
2. Only at night when it’s dark. 
3. Being more than 6 miles from shore 
4. Never 

12) How many hours of rest is the minimum required in a normal day? 
1. 14 Hours 
2. 10 Hours 
3. 6 Hours 
4. It doesn’t matter as long as my overtime is paid for.    ﻿ 

13) Which of the people onboard should have a job description? 
1. Captain and Chief Engineer 
2. Senior Officers 
3. Officers 
4. All Onboard ﻿ 

14) Where can you find information about your duties in the event of an emergency? 
1. Ask your superior 
2. In the Muster List 
3. In your employment contract 
4. Someone will always tell you, so you don’t need to know.
CD # 21 GMDSS
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























What does GMDSS stand for?
Global Maritime Distress Surface Search.
Global Maritime Distress and Safety System.
Global Maritime Disaster Search System.
Global Maritime Digital Safety System.

Which operator's certificate gives you the authority to sail on any GMDSS ship in all sea areas?
GOC
MOC
ROC
DSC

One of the most important advantages with GMDSS is that…
a ship can always communicate via satellite
a ship can always communicate via radiotelex
every ship has the same equipment
a ship in distress shall always be able to send a ship-to-shore distress alert

Ship-to-ship distress alerting is primarily based on…
satellite communications
digital selective calling in the VHF and MF bands
mobile telephones
VHF telephony

What does RCC stand for?
Research Coordinating Centre
Rescue Coordinating Centre
Resource Coordinating Centre
Retransmitting Coordinating Centre

What does MSI stand for?
Maritime Service Information
Maritime Surface Information
Maritime Safety Information
Maritime Security Information

Which equipment on the bridge is used for locating a SART?
3 cm (9 GHz) Radar
Radio Direction Finder
10 cm (3 GHz) Radar
Radar Direction Finder

Which VHF channel shall be used for bridge-to-bridge communications concerning safety of navigation and manoeuvring in the GMDSS?
Channel 08
Channel 13
Channel 16
Channel 70

On which VHF DSC channel shall all GMDSS equipped ships keep watch?
Channel 13
2187.5 kHz
Channel 16
Channel 70

Which is the distress and safety frequency for MF DSC?
2182 kHz
2187.5 kHz
8291 kHz
8414.5 kHz

What is the coverage of Inmarsat's geostationary satellites?
Global except the polar areas.
Global including the polar areas.
The Atlantic, Indian and Pacific oceans.
The Atlantic, Indian and Pacific oceans and the polar areas.

What is false regarding the Inmarsat EPIRB?
Instant alerting
It will be activated if the ship sinks
Global coverage
Minimum battery capacity is 48 hours.

What is false regarding the COSPAS/SARSAT EPIRB?
Global coverage except from the polar regions
It will float free and be activated if the ship sinks
Global coverage
Minimum battery capacity is 48 hours

What is the name of the international convention that regulates GMDSS?
STCW
SOLAS
MMSI
GMDSS

You have received the 9-digit MMSI of a ship in distress. In which ITU publication can you find the name of the ship?
List of ship stations
List of ship names
List of call signs and numerical identities
List of radio determination and special service stations

Sea area A1 means an area ........
within coverage of at least one Coast Station with VHF DSC and telephony
within 30 nautical miles from the coast
within 150 nautical miles from the coast
coastal water in sight of a Coast Station

Sea area A2 means an area ........
within Radar coverage of at least one Coast Earth Station
within 150 nautical miles from the coast
coastal water in sight of a Coast Station
within coverage of at least one coast station with MF DSC and telephony

Sea area A3 means an area ........
in one of the three major oceans
that is global
that is further out than 150 nautical miles from the coast
within coverage of an Inmarsat geostationary satellite

Sea area A4 means an area .......
outside A1, A2 and A3
with no ordinary radio communications
that is global
outside the ordinary ship traffic routes

What is the speed of radio waves?
Speed of sound
1,000 NM/h
1,000 km/h
Speed of light

What is the most important factor for the range of a VHF station?
The output power
The height of the antenna
The power supply
The size of the antenna

What is the most important factor for the range of an HF station?
The output power
The height of the antenna
The frequency
The size of the antenna

J3E is used for .......
distress communications on 2182 kHz
VHF telephony
SSB radiotelephony
TLX radiotelex

F1B is used for ........
distress communications on 2182 kHz
VHF telephony
SSB radiotelephony
TLX radiotelex

F3E is used for ........
distress communications on 2182 kHz
VHF telephony
SSB radiotelephony
TLX radiotelex

What is the function of squelch?
Automatic gain control
Automatic tuning
Dual watch
Eliminates audio noise when there is no traffic

Why is channel 16 a simplex channel?
Every ship within coverage shall be able to hear and communicate
It is cheaper
Simplex is less sensitive to interference than duplex
Not every country provides duplex service

What are the three first digits in a ship's MMSI indicating, for example 26501010?
The type and size of the ship
The nationality of the ship
The type of communication equipment
It is just a serial number

What is false regarding the ARQ mode in radiotelex?
It practically guarantees error-free data
Automatic exchange of identities guarantees connection with the requested station.
Communication is possible between only two stations at a time
Distress communications using radiotelex shall be established in the ARQ mode

What is false regarding the FEC mode in radiotelex?
It practically guarantees error-free data
A message may be transmitted to several receiving stations simultaneously
It does not require transmitters at the receiving stations
You do not need to know the selcall of the receiving station

How must a satellite antenna be mounted for approval in the GMDSS?
As near the transmitter as possible
As high as possible
With free line of sight in every direction
Midships

Why shall the SART be mounted as high as possible in the survival craft?
To protect the SART from sea spray
The flashlight shall be easily discovered by a rescuer
To protect the people in the survival craft from radiation
To increase the range

For how long time should an EPIRB be able to operate on its batteries?
36 hours
24 hours
48 hours
96 hours

Vessels operating in which sea area(s) are required to carry either INMARSAT or HF equipment or a combination thereof under GMDSS?
A3
All sea areas
A4
A3 and A4






CD # 22 Maritime English, Ship Familiarisation
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.











































1) Look at the image and choose what it indicates ? 
[image: ]
1. Gas tanker 
2. Bulk carrier 
3. Container ship 
4. Passenger ship 

2) Look at the image and choose what it indicates? 
[image: ]
1. Poop deck 
2. Bulbous bow 
3. Rudder 
4. Porthole 

3) Choose the correct option RoRo?
1. Ride on ride out 
2. Rhumbline on river ornico 
3. Roll out roll over 
4. Roll on roll off 

4) Choose the correct option ETA?
1. Estimated time of arrival 
2. Extra terrestrial alien 
3. Extra time allowance 
4. Estimated time of anchoring 


5) Which of the following is the correct abbreviations for two most common standard sizes of containers? 
1. TPC and FTC 
2. TEU and FEU 
3. DWT and FWA 
4. TFT and FFT 

6) What is the most common name for ships, which carry oil in bulk? 
1. General cargo ships 
2. RoRo 
3. Ferries 
4. Product tankers 

7) Who has the overall responsibility of the engine room and its maintenance? 
1. First Engineer 
2. Second Engineer 
3. Master 
4. Chief Engineer 

8) SAFETY Onboard is to ensure that all work procedures and operations are planned keeping in mind the following: 
9) The protection of personnel 
10) The protection of the pnvironment or (Protection from pollution) 
11) The protection of property 

12) Which IMO Convention deals exclusively with the Environmental Pollution? 
1. ISM 
2. MARPOL 
3. STCW 
4. SOLAS 

13) What is the most widely used general emergency alarm onboard ships? 
1. Signal of one short blast, one long blast repeated seven times 
2. Signal of seven short blasts, followed by one long blast 
3. Signal of seven long blasts followed by one short blast 
4. Signal of three long blasts 

14) What should you do when you hear a General Emergency Alarm? 
1. Contact bridge 
2. Evacuate the premises 
3. Shout Fire 
4. Proceed to your designated muster station 

15) Which is the recommended colour of the Foam Type Fire Extinguishers? 
1. Yellow 
2. Blue 
3. Black 
4. Red 

16) Where on ship would you find a Fire Blanket? 
1. Bridge. 
2. Engine control room 
3. Galley 
4. Radio room 
17) When a man falls overboard, which of the following is not the required immediate action? 
1. Shouting 'man overboard' 
2. Throwing a lifebuoy 
3. Sounding general alarm 
4. Keeping sickbay ready 

18) When a man falls overboard, we should immediately throw the nearest lifebuoy overboard. Is the statement correct? 
1. True 
2. False 

19) Choose the correct option.In ABC of first aid, A stands for 
1. Always 
2. Alleways 
3. Air Way 
4. Arteries 

20) Choose the correct option.In ABC of First Aid, B stands for
1. Breathing 
2. Breastline 
3. Bandage 
4. Bleeding 
5. 
21) Which list details the duties and responsibilities in case of emergency onboard? The statement is: 
1. Muster list 
2. Crew list 
3. Daily work list 
4. Hot work checklist 
5. 
22) Choose the correct option.OSC stands for 
1. On ship captain 
2. Over ship commander 
3. On scene co-ordinator 
4. On scene commander 

23) Which Publication gives detailed guidelines about conduct of various parties during Search and Rescue? 
1. IAMSAR Manual	 
2. IMO SAR Manual 
3. SOLAS 
4. MARPOL 
5. 
24) What is the Maximum possible Latitude? 
1. 90 degrees north 
2. 180 degrees north 
3. 270 degrees north 
4. 360 degrees north 

25) What is the Maximum possible Longitude? 
1. 90 degrees east 
2. 180 degrees east 
3. 70 degrees east 
4. 360 degrees east 

26) What is the primary function of echo sounder? 
1. To provide depth of water underkeel 
2. To provide speed of ship 
3. To provide course of ship 
4. To provide position of ship 

27) Safe speed is defined as that speed where __________. 
1. Vessel can be stopped within range of visibility 
2. Vessel is navigating at slower speed than vessels around 
3. Vessel can take proper and effective action to avoid collision 
4. Vessel is proceeding at manoeuvring speed 

28) Any action taken to avoid collision shall __________. 
1. Be a positive action, made in ample time and using good seamanship 
2. Be carefully checked until the other vessel is finally past and clear 
3. Result in passing at a safe distance 

29) This picture represents a power driven vessel more than 50 meters in length underway. Drag and drop the correct image for various lights shown here. 
[image: ]














30) Look carefully at the navigational lights shown by this vessel and click on the right option what these lights indicate. 
[image: ]
1. Vessel aground 
2. Vessel constrained by her draft 
3. Vessel not under command 
4. Vessel restricted in her ability to manoeuver 

31) Here is the image of four cardinal marks on one side. Match the light characteristics associated with each type of buoy. 
[image: ]

32) To indicate a new danger, a duplicate mark is provided besides the normal original mark. Is the statement correct? 
1. True 
2. False 

33) Is the statement correct? The sheet bend is used to join two ropes of different size together. 
1. True 
2. False 

34) Is the statement correct? Reef Knot is used to tie two ropes of equal size or thickness together. 
1. True 
2. False 

35) Which is the correct type of stopper to be used for wire ropes? 
1. Rope Stopper 
2. Chain Stopper 
3. Wire Stopper 
4. Nylon Stopper 
36) Select the most appropriate phrase to indicate that eye of first mooring line has been laid around the bollard on jetty? 
1. Mooring on jetty 
2. First fast 
3. First line ashore 
4. All fast 

37) Drag and drop on to the image 
[image: ]

38) Identify the flag and its meaning. 
[image: ]
1. A “ ALFA; I have a diver down; keep well clear at slow speed. 
2. B - BRAVO; I am taking in, discharging, or carrying dangerous cargo. 
3. D “ DELTA; Keep clear of me; I am manoeuvring with difficulty. 
4. E “ ECHO; I am altering my course to starboard. 











39) What is the meaning of Flag Hotel depicted above. 
[image: ]
1. I require a pilot. 
2. I am in process of embarking a pilot. 
3. I have a pilot onboard. 
4. Identification signal given by ship to pilot boat.





















CD # 30 Marine Lubricants
Состоит из шести глав.
В этом тесте необходимо отвечать на вопросы прямо а главах.  Ответы на все вопросы выделенны этим цветом. На один вопрос возможнен один вариант ответа.















































Subject 1
1) Lubricant base oils generally
1. 300 degrees С xx
2. 200 degrees С.
3. 150 degrees С.
4. 100 degrees С.

2) Crude oils are roughly classified as:
1. paraffinic, naphthenic and mixed base 
2. straight and branched chain
3. waxy and asphaltic
4. heavy and light.


3) The refined lubricant base oil properties are greatly influenced by
1. storage and treatment 
2. refining process 
3. chemical treatment
4. crude oil composition or origin 

4) Solvent extraction is a:
1. vacuum distillation process
2. physical process removing aromatics 
3. atmospheric distillation process
4. hybrid process.


Subject 2
1) What is ЕР (Extreme Pressure) oil?
1. Additive forming a protective chemical surface film 
2. High pressure hydraulic oil 
3. Standard gear oil
4. High maximum pressure cylinder oil.

2) Base oil combinations are selected to meet:
1. pour point
2. viscosity index 
3. operational conditions 
4. oxidation stability.

3) Oxidation inhibitors are:
1. removing oxygen from the oil
2. dissolving oxygen in the oil
3. preventing rust
4. counteracting chemical breakdown 

4) Friction modifiers or "oiliness additives" will:
1. improve the viscosity index
2. reduce friction under boundary conditions 
3. increase the pour point
4. extend lubricating oil life time



Subject 3 – вопрсов нет

Subject 4
1) What is mixed lubrication?
1. When formation of a fluid film is partly established 
2. When using grease and lubricating oil together
3. When mixing mineral and syntetic oils
4. When changing type of lubricating oil from time to time

2) What is elastohydrodynamic lubrication?
1. A combination of different lubricating oils.
2. I An additive to keep the viscosity index stable under various conditions.
3. The contacting surfaces are elastically deformed, distributing the load over a greater area.
4. I Water is added to the oil because it is not compressible and we can increase the load.

3) Why should "ЕР" additives only be used on ferrous metal surfaces?
1. Will be chemically bound to other metals
2. Will change viscosity
3. May be corrosive to other metals 
4. Will change chemical composition.

4) What   is   the   main   criterion   for   fluid hydrodynamic conditions?
1. Viscosity 
2. Anti-wear agents
3. Flow of lubricant
4. Temperature of bearing.

Subject 5 
[image: ]
Для выполнения теста на 100% необходимо нажать на каждое изображение и нажимать стрелку далее пока опять не появиться это изображение. Когда все 6 пройдены, нажимаем стрелку далее и выполняем тест!!!

1) What is the "NLGI" number of a grease indicating?
1. How water resistant the grease is 
2. How fluid or non-fluid the grease is
3. The grease compatibility
4. The grease expected life time.




2) In which type of equipment is low pour point and good wax depositing important?
1. I Refrigeration compressors  
2. Deck winches
3. Medium speed trunk engines
4. Hydrolic cranes.

3) What is the single most important element for gear oils?
1. Shear stability
2. Anti wear performance
3. Corrosion prevention
4. Viscosity 

4) What is typical BN level for a trunk piston engine operating on residual fuel oil?
1. BN70-BN100 
2. BN 30 - BN 40  
3. BN 40 - BN 50
4. BN5-BN10

5) What is the most important property of a lubricating oil for reciprocating air compressors?
1. Good anti-wear property
2. High viscosity index
3. Low carbon-forming tendency 

6) Good corrosion protection

7) What is a typical BN level for a two stroke engine cylinder oil?
1. BN70-BN100 
2. BN10-BN20
3. BN50-BN70
4. BN5 -BN10

Subject 6 – нету вопросов











CD # 36 Medical First Aid
Состоит из одиннадцати глав.
1-10 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
11 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов. Количество вопросов на которые надо ответить – 40.

























1) One of the main tasks of the blood is to transport oxygen to body’s cells. 
1. True 
2. False 

2) Oxygen is transported to the cells by blood vessels called veins. 
1. True 
2. False  
3) We have 3 circulatory systems for blood transportation. 
1. True 
2. False        

4) The red blood cells are responsible for the transportation of oxygen. 
1. True 
2. False 

5) Breathing is controlled by the respiratory centre in the brain. 
1. True 
2. False     
3. 
6) Inspiration is mainly caused by muscle activity of the Diaphragm. 
1. True 
2. False     

7) The respiration system, above all, reacts to carbon dioxide levels in the blood. 
1. True 
2. False     
8) A large dose of muscle relaxing medicaments can cause respiratory problems due to the reduced activity in the respiratory muscles. 
1. True 
2. False   

9) A patient who is shouting has an open airway. 
1. True 
2. False   

10) A sudden fall in blood pressure does not normally lead to circulation failure. 
1. True 
2. False   

11) Cardiac arrest leads to circulation failure. 
1. True 
2. False   

12) A limb with an external bleeding should be lowered to maintain circulation in order to supply the cells with oxygen and prevent cell death. 
1. True 
2. False   

13) A patient who breathes will always have a pulse rate? 
1. True 
2. False  

14) Normal resting rate of pulse in a healthy adult is about 2-3 beats per second. 
1. True 
2. False     

15) Respiration while resting is normal if the frequency increases to more than 20 ventilations per minute.
1. True 
2. False 

16) Cardiac arrest will always lead to unconsciousness. 
1. True 
2. False    
3.  
17) When performing C-P-R it is advisable to elevate the patient’s legs to secure sufficient blood to the chest and head. 
1. True 
2. False   

18) You should terminate resuscitation after 15 minutes. 
1. True 
2. False ﻿ 

19) Abdominal thrust is applied to remove foreign objects in the airway. 
1. True 
2. False   

20) The walls in the blood vessels are completely resistant to diffusion. 
1. True 
2. False   

21) An internal abdominal bleeding is not dangerous as it will stop bleeding by itself due to the increased pressure in the abdomen. 
1. True 
2. False   

22) If you are unable to give a patient with an increased circulation failure due to bleeding, intravenous treatment, he should promptly be given plenty to drink to replace lost fluid. 
1. True 
2. False 

23) Most adults will endure a loss of blood of 1 litre. 
1. True 
2. False   

24) Internal bleeding will never lead to circulation failure. 
1. True 
2. False   

25) Bleeding will always occur together with a fracture that breaks the skin. 
1. True 
2. False   



26) Shock and circulation failure are equivalent. 
1. True 
2. False   

27) To render correct first aid one should be certain that there is a fracture before treating the patient.
1. True 
2. False   

28) There are at least four distinct signs of fracture. 
1. True 
2. False   

29) The main goal of splinting is to render a pulling strain on the fractured bone ends, in order to prevent them from touching each other. 
1. True 
2. False 

30) Cooling  does not reduce pain in a sprain. 
1. True 
2. False       

31) The motor function and circulation distal to the fracture should always be assessed. 
1. True 
2. False  

32) R-I-C-E treatment has no effect if postponed more than 4 hours after the injury took place. 
1. True 
2. False 

33) Visible shortening of a limb is not necessarily a sign of a fracture. 
1. True 
2. False 

34) A good splint should prevent adequate blood circulation and compress nerves so the casualty will not feel any pain. 
1. True 
2. False   

35) It may be difficult to tell if there is a fracture or a sprain. 
1. True 
2. False 

36) Head injury will lead to circulation failure. 
1. True 
2. False   

37) Damage to the spinal cord will always result in immediate neurological malfunction. 
1. True 
2. False   

38) A haematoma can be caused by head injury. 
1. True 
2. False   

39) It is the increased pressure in the head that is fatal, not the bleeding itself. 
1. True 
2. False   

40) Symptoms of serious head injury are unconsciousness, low pulse rate and high blood pressure.
1. True 
2. False   

41) A spine/neck injury will always have priority over every other injury due to the risk of paralysis.  
1. True 
2. False   

42) An unconscious patient suffering from a major spine injury should not be placed in recovery position as this may increase the damage and lead to paralysis. 
1. True 
2. False 

43) A person suffering from a moderate to hard blow to the head should always be under close observation in the early hours after the accident, considering possible development of edeme in the head. 
1. True 
2. False     

44) A fractured spine will always imply unconsciousness
1. True
2. False

45) When treating an injury obtained by falling, it is of great importance to check the motor function in the extremities. 
1. True 
2. False   

46) Your aims are to maintain the airway, breathing and circulation, to remove any contaminated clothing, to identify the poison and to obtain medical aid. 
1. True 
2. False   

47) Spillage of corrosive chemicals is poisonous and can also result in burns. 
1. True 
2. False   

48) Flush away any residual chemical on the skin with plenty of cold water. Be sure that the water does not flush away from the casualty’s body. 
1. True 
2. False 

49) When an ambulance or  more qualified personnel arrives at the scene, there is no need to tell them about the poisonous chemicals inhaled since they will find out themselves. 
1. True 
2. False   



50) Food poisoning may be caused by eating food that is contaminated by bacteria or by toxins produced by bacteria that were already in the food. 
1. True 
2. False   

51) When we deal with food poisoning your aims are to encourage the casualty to rest, to seek medical advice or aid, and to give the casualty plenty of bland fluids to drink. 
1. True 
2. False   

52) There is nothing more you can do to prevent food poisoning, than ensure that frozen poultry and meat are fully defrosted before it is cooked. Cook meat, poultry, fish, and eggs thoughly to kill harmful bacteria. Never keep food lukewarm for long periods; bacteria can multiply without obvious signs of spoilage. 
1. True 
2. False 
3. 
53) You should always wash your hands before preparing food. Wear protective gloves or waterproof plasters if you have cuts on your hands. 
1. True 
2. False 

54) Oxygen treatment is most important with injury to the head/neck/spine.
1. True 
2. False 

55) You should not supply oxygen when resuscitating, as this will only disturb the treatment. It is however important to do so immediately after the resuscitation has ended. 
1. True 
2. False 
3. 
56) Grease and oil must never be used in connection with oxygen bottles, couplings and valves. 
1. True 
2. False 

57) All fires will burn easier and faster in an oxygen-rich environment. Therefore, do not use oxygen bottles near an open fire. Smoking is not allowed. 
1. True 
2. False  

58) You should only use double nose catheters when treating two patients on one oxygen bottle. 
1. True 
2. False 

59) Oxygen bottles should be handled with care and should be removed if they are exposed to heat. 
1. True 
2. False      


60) The respiration system of a person suffering from flame burns is very exposed to damage. 
1. True 
2. False   


61) To protect a burn injury we should never remove the patients clothing. 
1. True 
2. False 

62) A chemical burn from fluid must be bandaged firmly to prevent fluid from covering greater parts of the skin. 
1. True 
2. False   

63) Cooling of a third degree burn should be terminated after 15 minutes. 
1. True 
2. False 

64) A patient with a major burn is liable to develop circulation failure. 
1. True 
2. False   

65) A casualty with burns has less need for fluid. 
1. True 
2. False   

66) When there is an electrical burn there is a great danger of internal injuries. 
1. True 
2. False   

67) The position and direction of entry and exit wounds will alert you to the likely extent of hidden injury, and to the degree of shock that may ensue. 
1. True 
2. False   

68) A person under influence of alcohol will suffer from frost injuries quicker than a sober person. 
1. True 
2. False   
69) A seriously hypothermic patient should as soon as possible be placed in a warm bath (&gt;50ºC) to regain normal body heat. 
1. True 
2. False 
3. 
70) Moderate and deep hypothermia cause very unstable condition, and the patient must be inactivated and treated very carefully. 
1. True 
2. False   

71) The brain of hypothermic patients will consume less oxygen than usual. 
1. True 
2. False   

72) If a patient has heat exhaustion, the symptoms are weakness, vertigo, headache and nausea. Initially the skin is cool and clammy. 
1. True 
2. False   



73) You can threat a person with heat exhaustion by giving him salt and water. 
1. True 
2. False   

74) Heat cramps seldom occurs after excessive sweating precipitated by strenuous exercise. 
1. True 
2. False   

75) Heat-stroke can occur suddenly, causing unconsciousness within minutes. This may be signalled by the casualty feeling uneasy and ill 
1. True 
2. False   

76) When dealing with a heat stroke your aims are to lower the casualty’s body temperature as quickly as possible, and to arrange removal of the casualty to hospital. Do NOT use iced water as they may constrict blood vessels. 
1. True 
2. False   

77) What is the most serious damage to the tissue concerning damage by pressure? 
1. Pain and discolouring 
2. Dirt in the wound 
3. Increasing pressure and developing oedema.  

78) What is the most important treatment concerning a foreign body in the eye? 
1. Rinsing of the eye 
2. Local anaesthetic 
3. Wring the eye-lid to prevent blinking   

79) If there are signs of tendon damage, the tendon must be sutured by a surgeon before 
1. closing the wound. If so, put on a dressing until qualified treatment can be administered. 
2. True 
3. False   

80) Any major bleeding must be stopped before treating a wound. 
1. True 
2. False   

81) None of the tissue cells will die, only damaged when the casualty has a crush injury. 
1. True 
2. False    

82) Do not touch anything that is sticking to, or embedded in, the eyeball, or over the 
1. coloured part of the eye, when treating a person with a foreign body in the eye. 
2. True 
3. False   

83) A bandage is always applied to an open wound. 
1. True 
2. False 

84) Dressings should always be larger than the wound they cover. 
1. True 
2. False      
85) Bandages must be sterile before use. 
1. True 
2. False 

86) A triangular bandage is always used in its triangular shape. 
1. True 
2. False 

87) Once a bandage is in place it should be left alone. 
1. True 
2. False 

88) Parts of the body can be used as splints. 
1. True 
2. False 

89) Open weave roller bandages are used to support joints 
1. True 
2. False 

90) Improvised splints can only be made of solid materials. 
1. True 
2. False 

















CD # 50 ARPA
Состоит из девяти глав.
1-8 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
9 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























The plotting process can be divided into four separate operations, which? 
Detection - Selection - Tracking - Plotting 
Detection - Selection - Observation - Tracking 
Selection - Observation - Plotting - Detection 
Observation - Plotting - Tracking - Cancellation 

What does the target ship's aspect mean? 
The relative bearing of own ship measured at the target ship 
The true bearing of target ship measured at own ship 
The relative bearing of the target ship measured at own ship 
The true bearing of own ship measured at the target ship 

﻿What information is immediately apparent from the "true plot" of another vessel? 
Targets true course and speed 
CPA 
TCPA 
Own ships course and speed 

﻿What information is immediately apparent from the "relative plot" of another vessel? 
CPA 
TCPA 
Targets true course and speed 
Own ships course over ground 

﻿Which sensor input is required for the ARPA to be able to calculate and display true vectors? 
Course and speed 
None 
Course 
Speed 

﻿What do the sides in the relative plotting triangle represent? 
Targets true course and speed - Own ship true course and speed - Targets relative course and speed 
Targets true course - Own ship true course - Targets relative course 
Targets true speed - Own ship true speed - Targets relative speed 
Targets true course and speed - Own ship relative course and speed - Targets relative course and speed 

﻿How can true vectors be easily identified as the vectors on display? 
Own ship has a vector 
Own ship has no vector 
CPA and TCPA limits are broken and alarm is activated 
The vectors are the same direction as history dots 

﻿How can the true course and speed of a target be found when the display is showing relative vectors? 
By looking at the digital readout of target information 
By comparing target vector with own ships vector 
Can only be found by changing to true vectors 
By examining the vectors displayed 




﻿What does manual acquisition mean? 
The operator must select and acquire each target separately 
The operator selects an area of interest and targets inside the area are acquired 
The operator must repeatedly place the cursor on each target and press “acquire” 
The operator selects the limits of CPA and TCPA and targets breaking these limits are automatically acquired

﻿Comparing manual and automatic acquisition, which is most sensitive? 
Manual acquisition 
Automatic acquisition 
Same sensitivity 
Not relevant 

﻿Why at different times is there a change in the size of the tracking gate? 
There has been a change in course or speed 
Target swop has occurred 
The gate is continually changing 
The tracking gate size is always the same 

﻿What is the purpose of digitising the radar echoes? 
The ARPA tracking system only work with digital signals 
No special purpose 
Increase accuracy of system 
Reduce number of radar echoes 

﻿What is the result of “Target Swop”? 
A previously tracked target is no longer tracked 
A target will no longer be visible on the screen 
The operator can swap over vectors between ships 
A target has lost its vector and activates the lost target alarm 

﻿What is the result if there is no heading input to the radar? 
An un-stabilised Head-Up presentation will be the only one available 
The North-Up presentation will still be available 
An un-stabilised Course-Up presentation will be the only available mode 
A stabilised Head-Up presentation will be the only option 

﻿What does the lost target alarm tell you? 
A previously tracked target is no longer tracked 
A previously tracked target has moved out of range and is no longer tracked 
Radar failure 
To many targets are tracked 

﻿What is the purpose of a Guard ring on an ARPA? 
It provides automatic target acquisition 
It avoids the need to continually monitor the radar display 
It alarms to operator of a close CPA 
It provides warning of another target on the screen 





﻿Which ARPA presentation provides the information “closest to what you see through the bridge windows? 
True Motion, Course Up, True Vector 
Relative Motion, North Up, Relative vector 
True Motion, North Up, True Vector 
True Motion, Course Up, Relative Vector 

What is the correct speed input to an ARPA used for traffic surveillance? 
Speed through water 
Speed over ground 
Speed from GPS 
Speed from doppler log 

Does incorrect speed input affect the true vectors on an ARPA display? 
Yes 
No 
Only a little 
Only if the input is speed over ground 

﻿If the input gyro course is in error and fed to the ARPA, what can be expected? 
Errors in other ships calculated course and speeds 
No problem 
Error in other ships speed only 
Error in other ships course only 

﻿Does current and drift affect the CPA/TCPA calculations on a true motion, true vector presentation? 
No 
Yes 
Only a little bit 
Yes, very seriously 

﻿What influence does an error in speed and/or gyro input have on the calculated CPA and TCPA? 
None 
The CPA will be wrong but TCPA will be correct 
The TCPA will be wrong but CPA will be correct 
Both CPA and TCPA will be wrong 

﻿To which condition of visibility does Rule no. 5, Lookout, apply? 
Any condition of visibility 
Restricted visibility only 
Night-time only 
Good visibility at day-time 

﻿You have radars installed on your ship, are you required to use them? 
Yes 
No 
Only at night-time 
Only in restricted visibility 





﻿Ship A is navigating in an area of restricted visibility and has detected, by radar alone, a crossing ship, B, on her port bow. Which ship is the "Stand-On" vessel? 
None 
Ship A 
Ship B 
Ship A, as long the ARPA clearly shows that ship B is crossing from port 

﻿What is the meaning of this symbol?  
[image: ]
The target has been manually acquired and is in acquisition state 
The target has been automatically acquired and is in acquisition state 
Dangerous target 
Lost target 

﻿What is the meaning of this symbol? 
[image: ]
Dangerous target 
Lost target 
Acquired target 
Selected target 

﻿What is the meaning of this symbol? 
[image: ]
Lost target 
Dangerous target 
Auto acquired target 
Manual acquired target 
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Which of the following types of packaging are covered by the general term “cargo transport unit”?  (Select all applicable answers) 
Road freight vehicles. 
Railway freight wagons. 
Freight containers. 
Road tank vehicles. 
Railway tank wagons. 
Portable tanks. 
Large packagings. 
Inner packagings. 

﻿Which group of dangerous goods is generally understood to be the most hazardous for marine transportation?   
Organic peroxides. 
Toxic gases. 
Infectious substances. 
Flammable liquids. 
Oxydizing substances. 

﻿According to the IMDG Code, a freight container which is loaded with dangerous goods and which is intended for transport by sea, must display the placards as described by which of the following statements? 
On each side and on each end of the container. 
On each side and on the back end of the container. 
On each side only. 
On the back end only. 
On each side, each end and transversely in the middle of the top of the container.  

﻿Which of the following are contained in the Supplement to the IMDG Code?  (Select all applicable answers) 
Emergency Response Procedures for Ships carrying Dangerous Goods. 
The Medical First Aid Guide for Use in Accidents involving Dangerous Goods.  
The International Code for the Safe Carriage of Packaged Irradiated Nuclear Fuel, Plutonium and High-level Radioactive Wastes on board Ships. 
The Dangerous Goods List. 
The List of Generic and N.O.S. Proper Shipping Names. 

﻿Which of the following abbreviations is used to denote a Marine Pollutant in the Dangerous Goods List? 
[image: ]

﻿Which of the following is a correct statement? 
The hazard posed by a substance can arise from a dangerous reaction of the substance or article with other substances in the surrounding environment. 
Substances in the surrounding environment can have no dangerous impact on packaged dangerous goods. 
A dangerous reaction between a substance or article and other substances in the surrounding environment is only possible if those goods are packaged in a container constructed of soft and non water-resistant material. 
﻿Which Packing Group is assigned to substances presenting a low level of danger? 
Packing Group I.	 
Packing Group II. 
Packing Group III. 

﻿Which of these is the UN Packaging Symbol? (Drag &amp; drop the correct symbol into the box.) 
[image: ]       

﻿What is salvage packaging? 
Special packaging into which damaged, defective, leaking or non-conforming packages or dangerous goods that have spilled or leaked are placed for the purposes of transport for recovery or disposal. 
Packaging used only at the direction of a contracted environmental protection response company.  
Packaging which has been reconditioned after previous use. 
Packaging which is manufactured from recycled material. 
Packaging in which goods recovered from the sea are held, pending investigation by the appropriate authority. 

﻿Which of the following are considered a “Cargo Transport Unit” under the IMDG Code? (Select all applicable answers) 
Road freight vehicles. 
Railway freight wagons. 
Freight containers. 
Road tank vehicles. 
Railway tank wagons. 
Portable tanks. 
Military personnel vehicles. 
Large plastic barrels of 150 litres or more. 

﻿Within the IMDG Code, the term “labelling” refers to which of the following? 
Identification of the risks and hazards presented by substances contained in a package. 
Identification of the substance contained in a package. 
Identification of the risks and hazards presented by substances contained in cargo transport units. 

﻿Within the IMDG Code, the term “marking” refers to which of the following? 
Identification of the substance contained in a package. 
Identification of the risks and hazards presented by substances contained in a package. 
Identification of the risks and hazards presented by substances contained in cargo transport units.

﻿A ”Consignee” is which of the following? 
Any person, organization or Government that is entitled to take delivery of a consignment. 
Any person who prepares a shipment for transport. 
A shipment of dangerous goods. 
A member of a competent authority charged with the administration of the transportation of dangerous goods. 

﻿Proper Shipping Names and UN Numbers are used for which two primary purposes? 
To ensure that the substance, material or article can be readily identified during transport, especially in the event of an emergency. 
To provide the necessary information for the Master to be able to comply with reporting requirements in the event of a pollution incident. 
To complete the additional security documents when entering a port subject to a level “orange” security alert. 
To demonstrate compliance with MARPOL 73/78 when subject of a Port State Inspection. 

﻿Which of these packing labels is used to indicate a Marine Pollutant? 
[image: ]       
﻿The Medical First Aid Guide for Use in Accidents Involving Dangerous Goods provides advice intended for what? 
The initial management of chemical poisoning and diagnosis within the limits of the facilities available at sea. 
The comprehensive and total management of chemical poisoning and diagnosis to full recovery, with assistance from shore as required. 
The proper documentation to the flag state authority in the event of a fatality involving dangerous goods on a vessel. 
The limited care of casualties in exposure incidents involving liquid chemicals. 
The accurate transfer of information relating to a spilled cargo to the appropriate shoreside medical and environmental agencies.  

﻿Which organization today is responsible for maintaining the IMDG Code? 
The International Maritime Organization.  
The International Hazardous Goods Committee. 
The MARPOL 73/78 Advisory Committee. 
The Governments of different countries. 

﻿Where do you find the Dangerous Goods List? 
Volume 1 of the IMDG Code. 
Volume 2 of the IMDG Code. 
The Supplement to the IMDG Code. 
MARPOL Annex II 

﻿What does the abbreviation “IBC” stand for? 
Intermediate Bulk Container. 
Industrial Bulk Container. 
Internal Bulk Construction.  
International Booking Code. 

﻿What is a “UN Number”? 
A unique identifying number assigned to a dangerous substance, material or article.  
An unique international code assigned to a vessel authorized for the carriage of dangerous goods in packaged form. 
An emergency contact number for use in the event of an injury or pollution incident involving a dangerous substance as listed in the Dangerous Goods List in the IMDG Code.      ﻿ 

What does an EmS number refer to? 
The relevant emergency schedules for FIRE and SPILLAGE in the Emergency Response Procedures for Ships Carrying Dangerous Goods. 
The emergency response procedures as outlined in 46 CFR 32 of the US Federal Code of Regulations and expanded in the USCG Guidelines on the Transportation of Dangerous Goods by Sea.  
The relevant guidelines listed in the Anti-Pollution chapter in MARPOL. 

﻿What are the three states of matter used in the IMDG Code?  (Select all applicable answers) 
Solid. 
Liquid. 
Gas. 
Moisture. 
Frozen. 
Atmospheric. 

﻿When the UN Committee drew up the different classes of hazardous substances, what did they base the classification on?   
The type of hazard they present. 
Alphabetical order. 
UN Numbers. 
Laboratory tests. 
The number of packages of different types of dangerous goods. 

﻿How many Classes of Dangerous Goods are there in the IMDG Code? 
9. 
6. 
5. 
10. 
12. 

﻿Which of these statements defines a “Marine Pollutant”? 
A substance which is subject to the provisions of Annex III of MARPOL. 
A substance which, because of its tendency to degrade in seafood, or because of its low hazard potential to the aquatic environment is subject to the provisions of SOLAS and transported accordingly. 
A substance which requires the highest form of protection during transportation and is regulated accordingly by the International Transportation Authority. 

﻿Packagings must be so designed that they do not lose their contents through which of the following specific ways?   
Vibration. 
Changes in temperature. 
Changes in humidity. 
Changes in pressure. 
The normal conditions of transport. 
Being turned upside down. 
Damage through a side impact resulting in puncturing of the outer lining of the packaging only. 
Excessive adjacent heat resulting in melting of the lining. 

﻿What special mark must a recycled packaging have on it? 
REC. 
R. 
CAUTION!  RECYCLED PACKAGING. 
RC.

﻿Packagings in direct contact with dangerous goods must exhibit which of the following characteristics?  (Select all applicable answers) 
They must not be affected by the dangerous goods themselves. 
They must not cause a dangerous effect in the dangerous goods. 
They must be constructed of plastic. 
They will not go out of shape as a result of such contact.

﻿If you discover a leaking tank container on the weather deck, which of the following actions should you take? 
Report it immediately to the Duty Officer. 
Wash it away immediately. 
Examine the tank container and try and close off any leaking valves. 
Make sure the Chief Officer knows about it before arrival, so that no other vehicles drive through the spillage. 

﻿What do the letters IMDG stand for in the term IMDG Code? 
International Maritime Dangerous Goods. 
International Marine Distribution Guild. 
Intercontinental Maritime Definition Guide. 
Intermodular Material Demographic Graph. 
International Marine Danger Group. 

﻿Which two types of emergency are specifically covered by the schedules in the EmS Guide?  (Select all applicable answers) 
Fire. 
Spillage. 
Medical emergencies. 
Atmospheric pollution. 
Oceanic contamination. 

﻿The classes of chemicals in the IMDG Code are based on which of the following? 
The type of hazard they present. 
Alphabetical order. 
UN Number. 
Laboratory tests of different chemical groups. 
The average tonnage of different groups of dangerous substances shipped worldwide in packaged form. 
Airline rules. 

﻿Which of these symbols must appear on packaging containing radioactive substances? (Drag and drop the correct symbol into the box.) 
[image: ]

﻿Which of the following symbols would you expect to find on a thermal tank containing liquid of a high temperature? (Drag and drop the correct symbol into the box.) 
[image: ]       
 ﻿ 
Which of these labels would be attached to a package containing explosives? (Drag &amp; drop the correct symbol into the box.)  
[image: ]
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What is the name of the international standard for exchange of maritime digital electronic chart information?
S-52
S-75
S-57
S-84

ECDIS is an abbreviation for?
Electronic Chart Display and Information System
Electronic Chart Display System
Electronic Chart Display
Electronic Chart Data System

What is the number of the IMO resolution concerning ECDIS?
IMO res. A 817(19)
IMO res. A 572(14)
IMO res. A 827(19)
IMO res. A 728(17)

HMI is an abbreviation for?
Hydrographic Maritime Institute
Human Machine Interface
High Maritime Intelligence
Human Maritime Interference

A chart made by using the Lambert projection can be considered to present?
Correct areas
Correct angles
Correct area and angles
None of the above answers are correct

Chart projections are classified according to the type of projection surface used. How many commonly used surfaces are there?
1
2
3
4

A geoid refers to?
A theoretical model of the earth’s surface
A mathematical model of the earth’s surface
A satellite derived model of the earth’s surface
The actual size and shape of the earth.

How is an ellipsoid formed?
By rotating an ellipse about its minor axis
By rotating an ellipse about its larger axis
By moving a circle about its north/south axis
By moving a circle about its east/west axis

The “flattening” of the earth is approximately?
0
1/300
1/400
1/900

The surface of an ellipsoid is?
Uneven
Regular
Regular in direction N/S
Regular in direction E/W

The first satellite datum was based on:
Russian Glonass
American GPS
American NNSS
American DGPS

The worlds first satellite based datum was named?
WGS
WGS-72
WGS-84
GGS-72

What is the reference datum for GPS?
WGS
WGS-72
WGS 84
GGS-72

In worst case, how much can the difference be expected to be between local datum and satellite datum?
Up to 100 metres
Up to 500 metres
Up to 1000 metres
Up to several nautical miles

What is the main element of geographical data?
Description of positions
Description of objects
Geometric data
Hydrographic data

Where can you find information about standard terms used in connection with electronic charts?
IMO resolution A.472 (XII)
IMO resolution A.572 (14)
IMO resolution A. 817(19)
IHO resolution A.888 (21)

What is the definition of an Electronic Navigation Chart (ENC)?
ENC is a subset of ECDB
ENC is a subset of ECDIS
ENC is a subset of ECS
ENC is a subset of RCDS

What is a raster chart?
A raster chart is a chart made by giving digital values to each and every object on the chart
A raster chart is a chart made by giving analogue values to each and every object on the chart
A raster chart is a digital facsimile of the paper chart
A raster chart is a computerised chart

Which of the following chart is considered “intelligent”?
The paper chart
The vector chart
The raster chart
The computerised chart

The accuracy of data on a raster chart is exactly the same as?
The paper chart
The computerised chart
The Mercator chart
The Transverse Mercator Chart

What is the worst known difference between a local datum and WGS84?
1 NM
3 NM
5 NM
7 NM


According to IMO, what type of charts should be used on ECDIS?
A computerised chart
A raster chart
A vector chart
A scanned paper chart

What is the IMO definition of ECDIS?
A system which provides information based on GPS.
A system which provides information based on all available data.
A system that display hydrographic information in order to assist the safe navigation.
The display equipment used to display ENC

An ECDIS consists of?
ENC and ECDIE
ENC and GPS
ENC and RCDS
RCDS and GPS

ECS is a system that?
Does not meet SOLAS requirements
Meets SOLAS requirements
Will meet SOLAS requirements after Y-2000
Uses radar information

A raster chart is a chart that is?
Only used in a RCDS
Only used in a ECDIS
Used both in RCDS and ECDIS
Only used together with paper charts

Can a raster chart be displayed in head-up mode on today's ECDIS?
Yes
No
Only during route planning
Only charts with small scale

Vector charts can?
Only be displayed with North up
Only be displayed Head up
Only be displayed Course up
Can be displayed with any direction up


Can raster charts be “customised”?
Yes
No
Only when used on an ECDIS
Only when used on a RCDS

Can raster charts provide navigational warnings?
Yes
No
Only when used on an ECDIS
Only when used on a RCDS

What is the purpose of voyage planning?
To satisfy STCW regulations
To support the bridge team
To meet company regulations
To satisfy IMO regulations

How many stages are there in the planning of a safe voyage?
Two
Four
Six
Eight

A typical ECDIS “base display” shows the following information?
Coastline, seamarks and traffic separation schemes
Coastline, danger areas and soundings
Coastline, sub sea dangers and traffic systems
Information according to operators choice

What is the main purpose of the zoom function?
To select an area of special interest
To deselect an area of no interest
To reselect a previous area of special interest
To select appropriate chart scale to the actual situation

What is the main purpose of the pan function?
Deselect an area of no interest
Move the current chart on the screen
Change chart scale
Reduce displayed information


The ECDIS system can operate in how many modes?
Two
Three
Four
Five

What is the definition of a waypoint?
A way-point is a position on a leg
A way-point is the starting point of a voyage
A waypoint is a position where the ships course is to be changed
A way-point is the destination of a route

What is the definition of a leg?
A line connecting two turn-points
A line connecting the start and end position of a route
A line in the direction of the next way-point
A line in the direction of the previous way-point

How can the ships course change be described in detail?
By specifying ships present and future course
By specifying ships present and future heading
By specifying ships turn radius
The ships course change can not be described in detail

What is the purpose of the “off track” limit?
Give warning about possible danger
Assist in controlling the ship track from planned track
Give warning about possible grounding
Display warning limits on ECDIS

When the route planning process is completed, what should then be done?
Store the route in a safe way
Make a safety copy of the route data
Checking basic route data
Validate and check all route data

If own ships position is erroneous on an ECDIS system, what is the result?
All other positions on the chart are erroneous
The distances to other positions on the chart is faulty
The direction to other positions in the chart is faulty
All positions, directions and courses taken from the ECDIS are erroneous


What is the most important thing to know about computerised systems?
Their functions
Their features
Their technical capacity
Their limitations

Does STCW specify special training in use of ECDIS?
No
Yes
Only for ships over 10 000 DWT
Only for ships carrying dangerous cargo

When own ships position input to ECDIS is wrong, what is the result?
Nothing
ECDIS will give warning
ECDIS will automatically be switched off
Positions, range and bearings taken on the ECDIS will be wrong.

What is the effect of sailing in “Course mode”?
Ships course will automatically be corrected for off-set
Ships course will not be corrected for off-set, but the course will be adjusted towards the nearest way point
Ships course will be great circle
Ships course will be rhumb line

Before using a pre-programmed ECDIS route, what should you do?
Check all route data thoroughly
Check own ships position
Check all way points
Check log and gyro input

What does a navigator who uses an ECDIS require?
Good navigational knowledge and a professional job attitude
Good computer knowledge
Good system knowledge
Nothing special
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Which are the 4 most commonly occurring types of accidents?
Collision
Grounding
Leakage
Bad weather damages
Engine breakdown
Fire/Explosion
Personal injury

What kind of information does the Fire Plan contain?
The fire alarm signal, general fire instruction and your assignment for fire alarms
The location of all fire-fighting appliances and equipment on board
How to use the fire-fighting appliances and equipment on board
Information on how to handle different types of fires

Where can you find information about the various kinds of safety equipment you have onboard?
SOLAS
MARPOL
Safety Plan
General Arrangement Plan
Instruction manuals

What must you do if you detect a fire?
Activate the alarm signal, and try to extinguish the fire
Immediately muster at your fire station
Inform the bridge and wait for further information
Close all ventilation and then try to put out the fire

What is the first thing you must do if you see a person fall over board?
Sound the general alarm
Inform the bridge
Throw any floating device overboard
Meet at your muster station

What is OPA an abbreviation for?
Oil Prevention Association
Oil Pollution Act
Oil Producing Agency
Oil Producers Agreement

What is the connection between the quantity of oil transported at sea and the amount of oil spilled the last years? 
The quantity of oil transported has decreased and the amount of oil spilled has increased
The quantity of oil transported has increased and the amount of oil spilled has decreased
Both has increased
Both has decreased





Which of the 5 annexes includes regulation about garbage handling onboard ships?
Annex I
Annex III
Annex IV
Annex V

What kind of ships are regulated by OPA 90?
Oil and chemical tankers
Passenger ships, ferries and private vessels over150 tons
Dry bulk cargo
All kinds of ships

Which of the following are enclosed spaces?
Cargo tanks
Engine room
Pump room
Cofferdam
Fuel tank
Water tank
Forecastle

Do you need to measure oxygen levels before entering an enclosed space? 
Yes, always
No
Not if you measure for toxic gases
Yes, but not if you ventilate properly first for 24 hours

Do you need to report near accidents?
No, you only need to report an accident that has actually happened
You only need to report those near accidents caused by faulty equipment
You only need to report those near accidents that in your opinion could have caused sick leave for more than one day
Yes, it is your duty to report near accidents
Many near accidents will lead to more serious accidents. By reporting a near accident you may be preventing a serious accident from happening.

Why is it important that everyone onboard can understand and be understood in English?
Cargo documentation and handling instructions are usually in English
Local authorities in some ports may require crewmembers to take a test to check their ability to speak English
All navigational, engine room and pumping equipment is labeled in English
It is important for safety and is the standard language for communication of safety matters at sea

What should you avoid when receiving work orders? 
Having other people help you with your work
Swearing
Wasting time on having procedures explained
Misunderstandings
Emergency communications should be:
Short, accurate and in an easy to understand language
Repeated every hour until help has arrived
Only used if the “situation” has gotten out of control
Only sent by the navigation officer
All crew are required to:
Be able to communicate with each other in the vessel’s flag state language
Be able to communicate in an emergency language
Know how to operate all radio equipment onboard
Know how to operate the PA equipment onboard

Are you allowed to use any drugs if you are outside Coastal waters?
Yes, if you are off duty and have permission from the Master
No, not if you have less than 4 hrs until you go on duty
No, any use of drugs are strictly prohibited
Yes, if you have purchased them in a country where they are legal

In addition to a common language, what else is important for good communication in reference to human relations?
The ability to communicate in Morse code
The use of body language, posture and tone of voice
Knowledge of symbols used in flag signaling
Being able to shout loud enough so that you can be heard in noisy environments
In addition to a common language, the use of body language, posture and tone of voice is important for good communication in reference to human relations.
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Which statement is correct?
Burns should be treated with care to sterility, but these are seldom infected because the plasma that drains from them contains anti-bacterial matters.
Internal bleedings are difficult to localise, but they are seldom life threatening, because the hollow cavities in the body are too small to contain a serious bleeding.
It is correct to apply some pressure on a strain wound in addition to elevating the injury.
After sewing, the stitches should be left for at least 14 days to be sure there is a strong healing.

Acute abdominal condition should be treated with:
Give fluid by month
Give fluid intravenously
Give food by mouth
Relieve pain with painkiller, start with Paracetamol
Give stronger drugs (Morphine) at once

On what injury/injuries should ointment be used together with gauzed dressings?
On wounds only
On wounds and burns
On strains and burns
On burns only

What kind of wound is shown on the picture?
[image: E:\222\89\medcare\pic\MedicareQuestion.jpg]
Lacerations
Incisions
Abrasion
Puncture wound

In case of more severe pain, as in burns, fractures, acute abdominal pain etc, it might be necessary to employ more potent drugs such as morphine.
True
False

What is ICE an abbreviation for?
Immobilize – Conscious – Elevation
Ice – Compression – Examination
Immobilize – Compression – Examination
Ice – Compression – Elevation
The correct answer is; ICE is an abbreviation for Ice – Compression – Elevation.


Stewards or one of the persons in the galley department should be selected as the nurse onboard.
True
False

What is the most important measure taken by nurses to prevent spread of disease between patients?
Mouth mask
Use of special clothing
Patients in single rooms
Hand hygiene

A person who may have become a carrier of the disease should not be allowed to prepare or handle food or utensils until cleared for such duty by a doctor.
True
False

The patient room temperature should be?
18-21 Degree Celsius
21-24 Degree Celsius
20 Degree Celsius
23 Degree Celsius

In acute situations, how often should you monitor the primary parameters and record them?
Every 5 minutes
Every 15 minutes
Every 30 minutes
Every hour

What causes myocardial infarction?
Spasm (cramp) in the coronary vessels and heart wall.
Embolus traveling from the veins in the legs.
High glucose level in the blood.
Rupture of plaques in the coronary vessels.

What vaccine should not be trusted completely?
Tuberculosis
Tetanus
Mumps
Yellow fever



A person has the following symptoms: 1. Radiating pain to the neck, left arm and abdomen 2. Nausea 3. Breathlessness. What does these symptoms indicate?
Ischaemic heart disease
Pulmonary embolus
Cetoacidosis
Sepsis

What is the most common sexually transmitted disease in the western world?
Chlamydia and Gonorrhea
Syphilis
HIV and AIDS
Hepatitis A, B and D

Which of the following diseases may be treated with penicillin? Mark the answers you think are correct.
Chlamydia
Gonorrhoea
Hepatitis A
Syphilis
HIV
Hepatitis B and C

If the throat is covered with a grey layer, that is a sign for:
Diphtheria
Plague
Lepra
Typhoid

What sort of infection is Malaria?
Tropical bacterial infection
Tropical viral infection
Tropical parasite infection
Tropical fungal infection

Gingivitis is inflammation of the gums
True
False

In temperate climatic condition, how much fluid should you give a person suffering from dehydration?
1 litre
2 litre
3 litre
As much as the person wants to drink.

What should you give a person suffering from malnutrition the first two days?
Water only
Sugar and water or milk or soup
Small amount of normal food
As much food as the person wants

Which of the following procedures are correct to follow after a death onboard a ship?
Use a camera to take photographs, which might illustrate how the death occurred
Do not strip the body for all clothing
Make a brief description of each article and note any initials or names on the garments
If there is to be a post-mortem examination, the body should be put in a body bag and kept in a refrigerator or cold store

You should try to delay the birth, if the ship can reach the shore within some hours.
True
False

Which of the following statement are correct?
Once the widest part of the baby’s head is visible, make sure that the mother carry through a big push.
Do not pull on the baby’s head.
Pull on the baby’s shoulders.
Lift the baby away from the birth canal.
Smack the baby if he/she doesn’t cry.
Do not pull on or cut the umbilical cord

Even a small piece of the afterbirth left inside the mother can be dangerous.
True
False

Drag each stage to the correct "Symptoms and signs" description.
Mild contractions before the afterbirth is expelled – STAGE 3
Head emerges and the baby is pushed out rapidly – STAGE 2
Contractions, with an average interval of 10 - 20 minutes – STAGE 1

Drag each stage to the correct "What happens" description.
"Water" (amniotic fluid) break as the need for protection end – STAGE 1
Womb should contract, closing down the area to which the placenta is attached and stopping the bleeding – STAGE 3
Vagina stretches to allow the baby to be expelled – STAGE 2

What language should the medical record be written in?
The language spoken onboard
English
Both English and the language spoken onboard
The language required by the Company
The medical record should be available to the patient, on his request.
True
False

The weight of the patient is not necessary to inform the doctor about, only the age and sex of the patient.
True
False

When moving and transporting a patient, primary attention should be paid to the basal functions – ABC. What does ABC stand for?
Airway – Bleeding - Consciousness
Airway – Breathing - Circulation
Airway – Bleeding - Circulation
Airway – Breathing - Consciousness

In patients with suspected fractures, it is essential that you do not stabilise the limb/spine prior to transportation.
True
False
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6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.























1) The Temperature in the combustion chamber can vary between 850 C and ... C
1. 900
2. 1200
3. 1400
4. 2000

2) Where is the legal to dispose plastic?
1. Only at shore facilities
2. Within 3-12 miles ashore
3. Wirhin 12-25 miles ashore
4. Outside 25 miles ashore

3) The suction from the flue gas fun creates a ....... pressure un the combustion chamber
1. Atmospheric
2. Negative
3. Positive

4) Which key should be pressed if you want to see the history alarm log?
1. [INFO]
2. [ACK]
3. [LIST]
4. [PREV]

5) At which chamber temperature can the sluide door be opened and feeding of garbage can start
1. 200
2. 600
3. 750
4. 1200

6) When burning sludge, the sludge will be heated up to which temperature?
1. 45
2. 85
3. 145
4. As long as it is more than 0C it does't matter.

7) What can you throw overboard within 3 miles of the nearest land & in all inland waters?
1. You can throw floating lining and packing materials overboard.
2. The only thing you can't throw overboard is plastics.
3. You can throw food and glass overboard.
4. You cannot throw anyting at all overboard

8) The Temperature of the flue gas should not exceed......?
1. 200
2. 350
3. 650
4. 1200

9) What should the diesel oil pressure be at the diesel oil burner?
1. 0.4 bar
2. 1 bar
3. 16 bar
4. 60 bar

10) The Maximum suction height from the tank to the D.O. Burnet is.....?
1. 3.5m
2. 6.5m
3. 9m
4. 12m



















CD # 109 AIS - Automatic Identification System
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























What kind of system is AIS?
Transponder system
Radar system
ECDIS system
Navigation system

Seen from an operational point of view, how will you describe the AIS?
AIS is a semi automatic system
AIS is a manual system 
AIS is an automatic system
AIS is both manual and automatic 

Can AIS with MKD operate as a standalone system?
No
Yes
Only in ship to ship mode 
Only in ship to shore mode

In case of AIS overload, what can you expect? 
AIS will shut down 
AIS will “freeze” 
Targets far away drop out
Close targets drop 

How much can the AIS broadcast mode be overloaded without any significant operational effect? 
50 -100 % 
200 -300 % 
400 - 500 %
No overload is accepted 

The dynamic information update rate depends on?
ships size 
type of ship 
type of cargo 
ship speed and ROT

How often is the static information updated?
every 12 second 
every 3 minutes 
every 6 minutes
manual update when necessary. 


The AIS transponder is designed to transmit information? 
Automatically
Semi automatically
Manually
AIS is not transmitting at all

When should the AIS transponder normally be activated?
When the OOW think it is necessary
In coastal waters
In open waters
Always 

The AIS transmitted information is divided into three main groups, which?
Ship data, Speed Data and Course data
Dynamic data, Static data and Voyage related data
Dynamic data, Destination data and Cargo data 
Position data, Identity data and Dynamic data

How is the voyage related information updated?
Automatically
Semi automatically
Manually
No update is necessary

How is the AIS technical status checked?
Automatically
Manually 
No check is necessary
During annual service

The lost target symbol is shown where?
At the bottom of the screen
In the last known target position
At the top of the screen
In operator defined position

What is the IMO minimum display requirement for AIS?
AIS information on Radar
AIS information on ARPA
AIS information on ECDIS
AIS information on MKD


When using AIS the OOW should be aware of?
AIS information is always correct
AIS information may not be correct
AIS information is automatically switched off if not correct
AIS information need to be corrected before use

What is the accuracy of the AIS information?
The accuracy is good
The accuracy is not so good
The accuracy can be compared with the accuracy of radar
The accuracy is as good as the accuracy of the transmitted information

What happens when an AIS sensor fails?
Nothing
AIS display “not available”
AIS is automatically switched off
The AIS calculate the missing data

What is important to remember when using AIS for collision avoidance?
AIS may not give a complete picture of the traffic situation
AIS is more accurate than ARPA
AIS is not as accurate as ARPA
AIS is not allowed to be used for collision avoidance

When is static information entered into the AIS?
After the voyage is completed
During installation
At sea
At the AIS factory

What are the criteria for a dangerous target in AIS?
A target carrying dangerous cargo
A target calculated to violate preset CPA/TCPA limits
A target bigger than own ship
A target faster than own ship

What is the required minimum ship reporting capacity for AIS according to IMO performance standards?
1000
2000
4000
4500

What can happen in case of AIS overload?
The system will shut down
The system will freeze 
The system will give an alarm
Targets far away will drop out

Which of the following is defined as static information?
Navigational status
Safety related messages
MMSI
Route plan

The selected target symbol represents?
A manually selected target
An automatically selected target
A semi automatically selected target
A target lost by the AIS

Which of the following is defined as dynamic information?
Ship's speed over ground
Ship's call sign and name
Ship's destination and ETA
Ship's route plan














CD # 115 Security Awareness
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























Which of these conventions is The International Ship and Port Facility Security (ISPS) Code a part of?
SOLAS
MARPOL
The Anti Terrorist International Agreement
STCW - 95

Who is responsible for issuing an ISPS certificate?
The Port State
The Flag State
US Coast Guard
The insurance company

Which Security Levels requires the highest security alert
Security Level 1
Security Level 2
Security Level 3

What is a Continuous Synopsis Record ?
A plan including all security measures onboard
A record of the vessel's history
A record of all security incidents
A plan for continuous maintenance of security equipment

Which of the following areas may be possible restricted areas? (Review all answers) 
The Bridge
The Mess room
The Engine control room
The Cargo control room

Check the items that can be a possible threat 
bombing 
sabotage
hijacking
smuggling
cargo tampering
stowaways
piracy

What is a Declaration of Security?
A checklist jointly completed by the ship and shore security representatives
A checklist jointly completed by the Ship Security Officer and the U.S. Coast Guard
A document between the port and the cargo owner stating security
A document stating the ship’s security level


Who is responsible for the regular security inspections of the ship?
The Company Security Officer
The Classification Society.
The Port Facility Security Officer
The Ship Security Officer

Who is responsible for the development of the Ship Security Plan?
The Company Security Officer
The Classification Society.
The Port Facility Security Officer
The Ship Security Officer

Which two persons check the Declaration of Security?
The Company Security Officer
The local Coast Guard Officer 
The Port Facility Security Officer
The Ship Security Officer 

Which of following are security duties? (Review all answers)
Monitoring of restricted areas
Calibration of security equipment
Monitoring discharge of cargo
Checking ID of visitors onboard

During a bomb search, which of the following is an important principle to follow?
Try to reach behind bulkheads to find a bomb
Know exactly what a bomb looks like
Do not touch any suspicious packages
Throw any suspicious items overboard

From the list below, which is among the recommended actions for a vessel to take, on entering an area known for pirate activity?
To transit with maximum safe speed
To turn off all lights
To confine all ship’s personnel to one room onboard
To transit at night time only 

When is a visitor onboard required to present an ID?
Only on SECURITY Level 3
On SECURITY Level 2 & 3
On SECURITY Level 1. 2 & 3
Never

What percentage of the baggage is required to be checked at Security Level 1? 
25-50% of the baggage is required to be checked at Security Level 1.
The percentage is not specified.
100% of the baggage is required to be checked at Security Level 1.
5-15% of the baggage is required to be checked at Security Level 1.

What percentage of the ship’s stores are required to be inspected at Security Level 3? 
25-50% of the ship’s stores are required to be inspected at Security Level 3.
5-20% of the ship’s stores are required to be inspected at Security Level 3.
100% of the ship’s stores are required to be inspected at Security Level 3.
50-80% of the ship’s stores are required to be inspected at Security Level 3.






















CD # 121 Ship Security Officer Training System
Состоит из двенадцати глав.
1-11 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
12 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.











































A Ship Security Assessment is integral to the creation of your ship’s security plan.
True.
False.

Who is responsible for ensuring your ship completes a security assessment?
Ship Security Officer.
Company Security Officer.
Flag State Administration.
Recognized Security Organization.

Which of these tasks is performed as part of the SSA?
Assign security duties to ship personnel.
Implement measures to address weaknesses in ship security.
Train shipboard personnel in their security duties.
Assess the likelihood and potential consequences of security incidents.

The first step in completing an SSA is to:
Create a list of potential motives for security incidents against your ship.
Identify the key shipboard operations, systems, areas and personnel that are critical to protect.
List the existing security measures.
Develop an onboard security survey checklist.

Brainstorming potential motives for security incidents against your ship helps you to create possible threat scenarios.
True.
False.

What is the purpose of the Ship Security Plan?
Outline specific measures for your ship to move from security level 1 to 2 and from 2 to 3.
Outline the organizational structure for the ship.
Protect your ship from risks posed by security threats or incidents.
Detail the duties of shipboard personnel assigned security responsibilities.

Ship Security Plans all look the same.
True.
False.

Who is responsible for ensuring that your ship’s security plan meets the requirements of the ISPS Code?
Flag State Administration.
Ship Security Officer.
Recognized Security Organization.
Company Security Officer.

One of the categories of information that must be included in your SSP is:
Security arrangements.
Ship security survey.
Threat scenarios.
Weaknesses in security measures.

Your ship security plan must include procedures for responding to security threats, auditing security activities and interfacing with the port facility.
True.
False.
Records relating to breaches of security and changes in security level must be secured against unauthorized access and available for review by contracting governments.
True.
False.

Your ship is berthed at a port that is frequently used for drug smuggling. Which of these measures is it appropriate to implement?
Check the identity of everyone boarding the ship.
Secure unattended spaces that visitors have access to.
Limit the number of access points to the ship.
Suspend cargo-handling operations.

The Declaration of Security:
Details a ship’s security measures.
Addresses the security requirements shared between ships or between a port facility and a ship.
Identifies the security responsibilities of shipboard personnel.
States the reporting procedures to government contact points.

In which of these circumstances can your ship request a DoS?
Your ship is operating at a lower security level than the ship or port it is interfacing with.
There is a heightened security risk for your ship and a port facility.
Your ship is conducting activities with a port or ship that is not required to implement an approved security plan.
Your ship has added a new port to its list of ports of call.

Who is responsible for completing the DoS on behalf of the ship?
Company Security Officer .
Chief Officer.
Chief Engineer.
Ship Security Officer.

The DoS addresses the responsibility for the security of the water around the ship and the verification of increased threat levels.
True.
False.

Eavesdropping and phone taps are examples of which threat to information security?
Sabotage.
Espionage.
Terrorism.
Subversion.

Which of these types of information is considered sensitive?
Ship schematics and HR policies.
Way points and training records.
Planned maintenance schedule and emergency response procedures.
Voyage itinerary and departure and arrival times.

Information about your ship’s security arrangements and procedures is stored electronically. Which of these measures will help safeguard it from potential threats?
Passwords.
Protective markings.
Encoded email messages.
Work history verification.
A contractor is hired to install new navigation equipment onboard your ship while it’s berthed. For a period of time he’s left unsupervised and photographs schematics of the ship that he finds rolled up and stored in the corner of a nearby office. Later, from home, he hacks into the network and prints off information about the ship’s security procedures. Which of these information security measures would have prevented his unauthorized access?
Protective markings, reference checks, and passwords.
Firewall, protective markings, vetting and a secure network.
Secure area, passwords, a firewall and a secure network.
Secure area, passwords, a firewall and protective markings.

The purpose of profiling is to:
Make judgements about people based on their appearance.
Get beneath the outer shell of an individual to obtain a more complete picture.
Categorize people based on their nationality and ethnicity.
Identify different personality types.

Which type of profiling is used to obtain information about rival companies and their employees?
Criminal.
Commercial.
Industrial.
General.

Which statement about the use of profiling onboard a ship is true?
Only visitors can be profiled.
Detection equipment can be used in place of profiling.
Profilers need at least half an hour to gather the information they need.
A random selection process must be established.

What are the three tasks of a profiler?
Check documentation, conduct physical searches, ask questions.
Check documentation, ask questions, observe body language and behaviour.
Conduct physical searches, observe body language and behaviour, act intimidating.
Check documentation, conduct physical searches, act intimidating.

Which of these statements about profiling is correct?
Verify that answers to questions match up with what’s already known about the person being questioned.
Use only open-ended questions.
Check the ID of all visitors and some crew prior to boarding.
Pay less attention to body language and behaviour and more attention to answers to questions.

During a profiling interview, the service man you are questioning starts to act suspiciously. He is:
Friendly and cooperative.
Professional, courteous and forthcoming.
Talkative and good-humored.
Nervous, sweaty and trying to avoid eye contact.

Part way through a profiling interview with a supplier, the package the individual is carrying arouses your suspicion. What do you do?
Confront the individual and demand that he open the package.
Call for help on the radio.
Discreetly inform someone of your suspicions so he or she can get assistance.
Take the package and open it.

What is an IED?
A type of gun.
A homemade bomb.
An explosive.
An incendiary device.

Which statement about IED’s is true?
All IED’s have four common components.
All IED’s look alike.
IED’s are difficult to manufacture.
IED’s don’t cause serious damage.

The best way to identify an IED is to:
Measure the size of the object.
Shake the object.
Weight the object.
Recognize its components.

Which of these are indications that a parcel is suspicious?
The parcel smells like chocolate.
The parcel is addressed to no one in particular, arrives unexpectedly and seems heavy for its size.
The parcel came from Joe in the safety department and arrived quicker than expected.
The parcel is wrapped in clean, brown paper and is addressed to a crewmember from his wife.

What measures should be taken when handling mail?
Wear rubber gloves and protective clothing when opening suspicious looking mail.
X-ray or scan parcels before opening them.
Open any mail that looks suspicious.
Tear open letters with your hands.

Which of these weapons are widely available and commonly used by criminals and terrorists to further their aims?
Gun.
Incendiary device.
Liquid explosive.
Vehicle borne device.

Which type of equipment can be used to detect explosives?
CCTV.
Water cannon.
Particulate detector.
Metal detector.

This device can detect a package of drugs inside a large delivery of ship’s stores. What is it?
Pallet scanner.
Vapour detector.
Security container.
Access control system.





You can reduce the need for security guards in certain areas by installing:
Vapour detectors.
Metal detectors.
Water cannons.
Anti-intruder devices.

The best way to ensure you get the equipment you need is to:
Buy the most expensive equipment on the market.
Determine your needs and do some research.
Buy what everyone else is buying.
Buy the newest models.

Searches are often triggered by:
An increase in security level by the Flag State.
Lost baggage.
The receipt of a shipment of damaged stores.
News stories of stowaways.

For a search to be effective it must be:
Organized haphazardly.
Conducted by personnel with limited knowledge of the ship’s layout.
Centrally controlled.
Inclusive of all personnel.

Which information should be included in your search plan?
Areas to be searched.
Personnel to be involved in the search.
Known hiding spots to be searched.
Areas to the searched and personnel to be involved in the search.

The person who takes a bomb threat call has an opportunity to extract information about the bomb from the caller.
True.
False.

What type of bomb search should you conduct to avoid panic when the credibility of the threat is in doubt and you don’t want to disrupt ship business?
External search team.
Nominated officers search.
Crew search.
Known hiding spot search.

Which of these procedures should crew follow when conducting a search?
Stand quietly in various spots around the space, listening for unusual sounds like the tick tock of a clock mechanism.
Search the perimeter of the space up to a height of 5 feet.
Wait in the area they’ve finished searching until they’re contacted for a status update.
Conduct random or spot checks of logical threat areas.





Which of these actions should crew take if a suspicious object that may be a bomb is located during a search?
Throw the object overboard.
Cover the suspicious object with a box or blanket.
Confirm with their search partner that the object found is suspicious.
Place the object in a desk drawer or file cabinet.

The most effective way to combat the threat of drug smuggling is to:
Organize crew into pairs and conduct weekly searches of the ship.
Combining routine, but irregular searches of the ship with spontaneous targeted searches.
Perform routine, but irregular searches using teams of two or more personnel from the same department.
Perform spontaneous targeted searches using teams of two or more personnel from the same department.

The best way to prevent stowaways from boarding your ship is to:
Conduct routine, but irregular searches of the ship.
Conduct a Nominated Officers search.
Search the ship when you arrive at port and again just after leaving.
Seal spaces that are not in use while in port, and perform a search of the ship before leaving.

The International Maritime Bureau Piracy Reporting Centre attributes the increased numbers of hijackings to:
The greater involvement in piracy of well-organized and armed crime networks.
Higher crime rates around the world.
More crew involvement.
Easy access to military weapons.

Which of these precautionary measures can reduce the threat of piracy, if implemented?
Stay at least 15nm away from the shore.
Sail at full speed.
Plan to arrive at port at night.
Turn off all of the ship’s lights at night.

Which of these actions should you take if your ship is successfully boarded by armed pirates?
Fight back.
Scream in fear and refuse to cooperate.
Keep quiet and ignore any questions you’re asked.
Assure your captors that you’re not planning an attack to overthrow them.

Which of this information must be included in a piracy attack alert?
The number of pirates/highjackers.
The type of weapons being carried by the pirates/highjackers.
Your ship’s name and call sign.
The number of crew onboard.

Assign men to search men and women to search women unless a device such as a metal detector is used.
True.
False.

Only search vehicle compartments where you suspect objects may be hidden.
True.
False.
Which of these statements about drug smuggling is true?
Drugs are difficult to conceal onboard a ship.
Drug smuggling is only a problem in certain ports, so only ships sailing in those ports need to implement preventative measures.
The preventative measures you incorporate into your ship’s security plan should be exhaustive, regardless of the level of threat identified by your ship’s security assessment.
The risks to ships are not restricted to specific areas or trading routes.

What do crew, visitors and contractors all have in common?
They’re all employees of the ship.
They’re all onboard the ship for the duration of its voyage.
They all have opportunity to smuggle drugs.
They’re all trained in ship emergency procedures.

Which of these statements about drug smugglers modes of operating is true?
Individual entrepreneurs usually smuggle large quantities of drugs.
Drugs smuggled by an organized conspiracy are usually concealed in a primary ship system such as the engine room or in a tank, void or compartment.
Drugs hidden by individual entrepreneurs are usually difficult to detect.
An organized conspiracy usually smuggles a small amount of drugs.

Which of these are indicators that an individual may be a drug smuggler?
The individual spends his or her free time hanging out with others.
The individual wears bulky or out of season clothing.
The individual makes small local purchases.
The individual is disinterested in the ship’s cargo.

Which of these measures would you implement to prevent drugs from being smuggled onboard your ship while it’s berthed?
Maintain restricted areas.
Check a portion of the bags and packages brought onboard.
Search some of the packages, spares and stores received.
Eliminate fore and aft deck watch at night.

If drugs or suspected drugs are found onboard your ship, follow the five C’s. Confirm, Clear, Cordon, Control and:
Change.
Chuck.
Check.
Cheer.

When handling drugs:
Wear skin protection and a facemask.
Briefly inhale powders, fumes or vapours to verify the substance is a drug.
Shut off the ventilation in the room where the drugs are being stored to ensure any vapours or fumes do not spread to other parts of the ship.
Test out the potency of the drug.

If drugs are discovered onboard your ship:
Notify the authorities after you arrive at the next port of call.
Write a report a few days after the event and describe everything that occurred.
Disembark crew and passengers as quickly as possible at the next port of call so the authorities can conduct their investigation.
Ensure the witness to the discovery signs your incident report.

Successful training programs build on learners past experience, are delivered with enthusiasm, present relevant information in a logical sequence and invite participation through varied activities.
True.
False.

The process of learning involves doing, reflecting, linking and:
Planning.
Contemplating.
Acting.
Explaining.

How many different learning styles are there?
1.
2.
3.
4.

This is an example of a good learning objective: Given a mock-up of an explosive device, identify the components of the device with 100% accuracy.
True.
False.

All training programs have a beginning, a middle and an end.
True.
False.

The middle portion of a training program takes the most time to plan. Which of these items will assist you in planning and delivering this portion of the program?
An equipment list.
A description of the content to be covered.
Session plans.
A list of the page references to regulations and other documents that will be referred to in the program.

Using x-ray equipment, perform a baggage search to locate a small hunting knife. Which instructional technique is appropriate for this objective?
Brainstorming.
Presentation.
Questioning.
Demonstration.

You’ve just completed a training drill. Which of these guidelines should you follow when giving feedback?
Listen to your hunches and give appropriate feedback.
Ask to give feedback or wait to be asked.
Take a one-hour break for lunch and give feedback after you resume.
Give lots of information and examples.



CD # 122 ISO 14001 Environmental Management
Состоит из пяти глав.
1-4 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
5 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























What is ISO 14001?
An International standard for environmental management.
IMO regulations dealing with pollution from ships.
Standard with guidelines for vessels and ship managing companies pertaining to safety and protection of the environment.
International Ship Operator’s list of approved garbage reception facilities in seaports.

The strategy for pollution prevention and protection of the environment has changed over the years.
Last decade the focus has been more on Being “pro-active” by preventing pollution from occurring.
Dealing with the pollution problems locally in each country.
Leaving it to the industry (including shipping) to implement standards for pollution control and environmental protection.

Which environment is ISO 14001 about?
Working conditions and the environment onboard vessels.
Pollution of the oceans from ships.
The environment around us i.e. surroundings in which an organisation operates.

Implementation and maintaining ISO 14001 – Environmental management – in a company should involve all employees.
Yes
No

ISO 14001 are a set of rules and regulations that all ship managing companies must comply with.
Yes
No

A company having ISO 14001 certificate must have a documented environmental policy.
Yes
No

ISO 14001 requires the top management of the company to commit themselves to prevent pollution, continuous improvement, comply with rules and regulations and _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _.
comply with company requirements.
appoint an “ISO 14001” officer.
annually present a written review to the board.



Also for ISO 14001 – environmental management – we have an important improvement process where we can use the phrase : “Plan what you do”, _ _ _ _ _ _ _ _ _ _ _ _, “Record it”
“Do what you plan”
“Give precise working orders”
“Ensure safety”

To ensure continuous improvement of our environmental management system we use a PICC circle where the three first key words are: PLAN – IMPLEMENT – CHECK. What is the fourth key word?
CORRECT
CONTINUE
CALIBRATE
CALCULATE

In ISO 14001 the definition of “Environment” is : “Surroundings in which _ _ _ _ _ _ _ _ _ _ operates”
an organisation
a vessel
a shipping company

An important part of ISO 14001 is “environmental aspect”. The definition is “Element of an organization’s activities, products or services that can _ _ _ _ _ _ _ _ _ _ _ the environment
pollute
interact with
harm

An important part of ISO 14001 is “Environmental impact” The definition is “Any _ _ _ _ _ _ _ _ _ _ the environment, whether adverse or beneficial, wholly or partially resulting from an organization’s activities, products or service.
pollution of
damage to
change to

Why are we so concerned about ballast water in connection with ISO 14001 – environmental management?
It affects the stability of the vessel.
Use of chemicals in the ballast water can damage the paint and steelworks of the tanks.
Spreading of exotic organisms in the water can lead to irreversible processes effecting human health and industrial activities as well as the ecological balance of the seas.

Why are we so concerned about the escape of and use of Freon in connection with ISO 14001 – environmental management?
It is a harmful substance and might cause skin injuries to people.
It affects the ozone layer.
It is a very expensive commodity.

Where can we dispose of plastic?
At a shore reception facility only.
At a shore facility and at sea in accordance with MARPOL regulations.
At a shore facility and at sea only outside restricted areas.

Is it required that every vessel shall have a vessel specific “garbage management plan”?
No, only for vessels trading on USA.
Yes.
No, only for vessels not having incinerator.























CD # 123 Risk Assessment and Management
Состоит из семи глав.
1-6 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
7 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.











































How many percent of all accidents can be related to human error? 
80% 
90% 
70% 
50% 

Check the boxes on the factors that can be categorized as human errors 
Ignorance to the hazards of a job 
Lack of understanding or skill in how to work safely around hazards 
Faulty equipment 
Carelessness. 
Weather conditions 
Recklessness 
Task vs. safety focus 
It won’t happen to me” attitude     
 
What is the first step in a risk assessment? 
Likelihood estimation 
Risk identification 
Consequence estimation 
Risk evaluation   

Risk estimation is? 
Calculating how many times an accident has occurred 
A system to see the consequences 
Rating likelihood and consequence 
Identifying accidents 

What is a definition of “ likelihood”? 
How often a risk can lead to an accident 
How often an accident can lead to a risk 
How much I like a risk 
How often I will do a specific work 

What is a definition of “consequence”? 
How many times an accident occur 
How likely the consequences are 
The outcome of an accident 
The reduction of likelihood   

What do you do with a “Risk Profile Matrix”? 
Reduce the risks of an accident 
Reduce the consequences of an accident 
Check how many times you can do a dangerous job without accidents 
Check if a risk is acceptable

If a risk is not acceptable you can  
Continue with your work but be very careful 
Reduce the likelihood and/or consequence 
Get more people to help with the job 
Leave the job to someone else 

Check which of the following actions that can be used to reduce the risk in a job 
Figure out a different way to do the job 
Let someone else do the job 
Change the physical conditions 
Modify the job procedure 
Change the frequency of performing the job 
Wear personal protective equipment 
Identify better tools to do the job  

What should you do before performing any job onboard? 
Ask your superior 
Follow procedures and apply informal risk management 
You do not have to follow procedures if you have done a thorough risk analysis Check how many persons you can get to help you
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Which of the following is most likely to lead to a fire or explosion?
Open drums of flammable liquids stored adjacent to a bulkhead in which a hole is being cut using an oxy-acetylene lance.
Performing hot work repairs on an open deck during a ballast passage.
Welding in a double bottom tank in a dry dock.
Welding at night in the ship yard.

What approach does the ISM Code take towards safety?
It is based on Risk Assessment and Risk Management.
It requires extensive checklists to be completed at every stage.
It contains highly detailed procedures, covering all aspects of shipboard operation.
It seeks to identify persons responsible in the event of an incident.

Before any hot work task can take place, what is required? 
Careful assessment of all related hazards, and the probability of their occurrence, to determine the severity of the risks involved.
Only an order from the Master or Chief Engineer.
The completion of the record in the “Hot Work file”, so that the vessel will pass its audits.
A quick check of the intended hot work site to make sure everything seems safe. 

Which of the following is the definition of a “Risk Assessment”?
A thorough and careful analysis of what, in the range of operations, could cause harm, so that decisions can be made as to whether enough precautions have been taken, or whether more should be done to prevent harm.
A brief visual check of the work site carried out immediately before the work is started, to ensure that the area is safe and clean.
An investigation into the circumstances which have led to an incident, such as an explosion that occurred during a welding repair.
The full and detailed briefing of all team members involved in a work task, to ensure that everyone is aware of their roles and responsibilities.

A broken hand rail at the bottom of a ladder in a cargo tank is to be cropped and a replacement length welded in place. Which of the following “permits to work” will be required before this job can be started? (Select all applicable answers)
A “Hot Work Permit”.
An “Enclosed Space Entry” permit.
A “Permit to Work Aloft”.
A permit to “Work over the Side”.
No permit will be required.




A retaining bracket is to be re-welded to the bottom of a bulkhead in a storeroom off the engine room. Which of the following areas will need to be checked for the presence of combustible materials before any hot work is commenced? (Select all applicable answers)
The storeroom where the repair is to take place.
Shelving above and immediately to one side of the hot work location.
The space directly below the work site.
The space on the other side of the bulkhead.
The complete machinery space.
The Engine Control Room.

What is the definition of “cold work”?
Work which cannot create a source of ignition. 
Work that creates a cold spark.
Work that will still create a spark in temperatures of less than 15.6°C.
Work that creates a spark in water.
Work which creates a source of ignition. 
An atmosphere in which no flammable vapours are present.

When is a tank, compartment or container considered to be gas free? 
When sufficient fresh air has been introduced into it to lower the level of any flammable, toxic, or inert gas to that required for a specific purpose.
When sufficient fresh air has been introduced into it to raise the level of oxygen present to that necessary to sustain human life, that is above 17.9%.
When sufficient inert gas has been introduced into it to prohibit the possibility of combustion in the presence of a source of ignition.
When a Senior Officer declares it to be fit for entry.

Which of the following is the ISGOTT definition of a “Responsible Officer” (or “Responsible Person”)?
A person appointed by the employer or the Master of the ship and empowered to take all decisions relating to a specific task, having the necessary knowledge and experience for that purpose.
A person appointed by a terminal and empowered to take all decisions relating to a vessel alongside, having the necessary knowledge and experience for that purpose.
A seafarer with a Certificate of Competency.
An Officer who has been trained how to complete standard reporting forms.

Which of the following is considered as the best location on board for hot work?
A designated space, such as the engine room workshop.
A dedicated area, such as behind the accommodation block.
At the actual location of the required repair.
Inside a gas free compartment.
Anywhere within the machinery space. 
Anywhere behind the tank deck area. 
There is no area on a tanker which is better than any other for hot work; it is equally dangerous all over the ship.

Which of the following regulates hot work outside the designated space? 
The SMS by means of a Permit to Work system.
The SMS through the company Risk Analysis Programme.
Instructions in the Chief Engineer’s Standing Orders.
Hot work outside the designated space is not regulated. 

The ship is alongside, but is not working cargo. The vessel’s SMS allows welding in the engine room workshop without a permit, considering it a designated hot work space. The terminal regulations do not permit hot work alongside. The Chief Engineer wants to repair a small crack on a section of pipeline that has been disconnected and taken down below. Can the crack be welded? (Select the most correct answer)
No (even though the SMS makes provision for it, terminal regulations take precedence). 
Yes (even though terminal regulations prohibit it, the SMS takes precedence on board).
Yes, but the terminal must be informed.
Strictly speaking no, but it might be possible during the night. 

A hot work modification is to be carried out in the middle of the after transverse bulkhead of an engine room spare gear store. Which of the following could be at risk of damage directly on the other side of the bulkhead in the fitter’s workshop? (Select all applicable answers)
Paint. 
Wooden shelving.
Welding electrodes, contained in a plastic wallet, stored on the wooden shelves.
Electrical cables on the opposite transverse bulkhead of the fitter’s workshop.
The electric light fittings on the deck head in the fitter’s workshop.
Spare small bore air and hydraulic hoses hanging in racks on the adjacent longitudinal bulkhead in the fitter’s workshop. 

What is the maximum concentration of hydrocarbon gas permitted in the atmosphere in a space (not a designated space) before hot work can take place?
Less than 1% LFL.
Less than 3% LFL.
Less than 1% UFL.
Less than 2% Oxygen content.
Less than 8% Oxygen content.

A section of pipe has been disconnected and taken aft to a dedicated gas safe area on the poop deck behind the accommodation block. Is it necessary to perform a Risk Assessment?
Yes.
No.




Fire safety precautions that may be taken in preparation for hot work might include which of the following? (Select all applicable answers)
Briefing personnel on action to be taken in the event of an emergency. 
Dressing personnel in fire fighting gear to be fully ready to move immediately in the event of an emergency.
Bringing extinguishers and other equipment to a stand-by location.
Starting the main or emergency fire pump and running and charging fire hoses.
Rigging fire curtains and blankets to contain welding sparks and molten slag.
“Damping down” or performing boundary cooling in adjacent spaces. 
Arranging for the testing of the atmosphere at the hot work site and in adjacent spaces.
Inerting adjacent spaces, where appropriate.

It is intended to burn some old brackets off a bulkhead in the after end of the machinery space. The bulkhead to a lubricating oil storage tank is 480 mm away from the closest bracket. Can the repair take place without further precautionary measures being taken? 
No.
Yes.

For hot work to take place in the machinery space, what is the minimum distance that it can take place from a bunker tank containing fuel oil?
At least 500 mm.
At least 600 mm.
At least 1000 mm.
No welding can take place in a machinery space where any of the fuel storage tanks has not been cleaned to hot work standard and inspected and tested to that effect. 

At which of the following times should hot work be prohibited on a tanker? (Select all applicable answers)
During cargo operations.
During ballast operations.
During tank cleaning.
When gas freeing.
During purging or inerting.
At anchor.
At a lay-by berth where no cargo operations are to take place.
At night.

How might the tank lining (coating) on the bottom of a tank be protected from damage due to falling molten slag? (Select all applicable answers)
By rigging fire resistant blankets. 
By putting a “heel” of water in the bottom of the tank.
By inerting the tank.
By rinsing the bottom with Odorless Mineral Spirit before commencing hot work.


A hot work repair is to take place on a bracket in a forward fuel tank. The tank has been cleaned and gas-freed but how should the heating coils in the tank be treated before that hot work begins?
They should be flushed or blown through with steam and then tested to ensure they are clear of hydrocarbons.
They should be continuously blown through with fresh air while the hot work repair is taking place.
They should be disconnected and removed from the tank.
They should be continuously blown through with inert gas while the hot work repair is taking place.

On this tanker, preparations have been made for a damaged section of heating coil in cargo tank 2 port to be cut away and replaced. The tank has been thoroughly cleaned, gas freed and vented. All enclosed space entry procedures are in place. The vessel is at sea and all other compartments are inerted, but still contain residues. What options are there for preparing the adjacent tanks, before this repair can safely take place? (Select all applicable answers)
They must be cleaned and gas freed, with the hydrocarbon vapour content reduced to not more than 1% LFL and maintained at that level. 
They must be emptied, purged and the hydrocarbon vapour content reduced to not more than 2% by volume and inerted.
They must be completely filled with water.
It is not necessary to do anything with adjacent spaces.
They must be cleaned but it is not necessary to gas free these spaces.

On this tanker, preparations have been made for a damaged ladder in cargo tank 4 centre to be cut away and replaced. The tank has been thoroughly cleaned and gas freed. The vessel is at sea and all other compartments are inerted. How should the inert gas line to 4 centre be treated, before the repair can take place? 
It should be purged with inert gas to not more than 2% by volume of hydrocarbon vapour and isolated.
It should be purged with inert gas to not more than 8% by volume of hydrocarbon vapour and isolated.
It is not necessary to do anything with the inert gas line to 4 port.
It must be flushed through and gas freed, with the hydrocarbon vapour content reduced to not more than 1% LFL and maintained at that level.

If hot work is to be undertaken on a bracket under a tanker’s catwalk, at a height of 900mm above the tank deck, what options are available for preparing cargo tanks within a 30m radius of the hot work location to the required safety standards? The vessel is at sea. (Select all applicable answers)
They should be cleaned and gas freed, with the hydrocarbon vapour content reduced to not more than 1% LFL and maintained at that level. 
They should be emptied, purged and the hydrocarbon vapour content reduced to not more than 2% by volume and inerted.
They should be completely filled with water.
There is no requirement to prepare such compartments in any way for hot work at this height above the deck.
They should be stripped and inerted to not more than 8% oxygen content by volume. 

On this tanker, a hot work repair is to be carried out at a height of 760mm above the tank deck. The ship is not inerted. Cargo tanks within a specified distance, including those diagonally positioned, should either have been cleaned and gas freed to hot work standard, or completely filled with water. What is that specified distance?
30 metres.
100 metres.
25 metres.
50 metres.

A what minimum distance is a hot work repair permitted from the bulkhead of a bunker tank, assuming it has not been cleaned and tested for hot work?
500 mm.
30 m.
2 m.
30 mm.

Wherever possible and for safety, which of the following is the most preferable location for performing a hot work repair on a cargo line valve?
In the designated space, having been disconnected and removed from the tank deck. 
In position.
In a gas-free cargo tank.
On the poop deck, behind the accommodation, having been disconnected and removed from the tank deck. 

How can a welder, working in a confined and restricted area and in close contact with the ship’s structure, be additionally protected against the risk of electric shock through touching the hull or frames?
By providing dry insulating mats or boards.
By wearing knee length boots.
By wearing a cotton boiler suit. 
By flushing down the area with fresh water before welding commences.

In general terms, how should hot work close to bunker tanks be considered?
In the same way as hot work above the tank deck.
In the same way as hot work inside a cargo tank.
In the same way as hot work on pipelines.
In the same way as hot work in a dedicated area.

On this tanker, a hot work repair is to take place in cargo tank 2P. Tank 3S is diagonally across the point at which longitudinal and transverse tank bulkheads of the two tanks meet. Is tank 3S considered to be adjacent for the purposes of hot work requirements?
Yes.
No.

A hot work repair is required on a pipeline on the deck of a tanker. The first available flange at which the pipeline can be disconnected and isolated is a long way aft, just in front of the pumproom. What recommended precaution will you follow while the repair is being carried out?
Continuously through-ventilating the pipeline with fresh air and monitoring the exhausting air for hydrocarbon vapour.
Flushing the pipeline continuously with fresh water.
Periodically blowing through the pipeline with inert gas and monitoring for oxygen content of at least 15%. 

A level monitor is to be installed in a slop tank on a chemical tanker that is not inerted. Hot work is required. How should the space be treated before that work starts? (Select all applicable answers)
The tank should be thoroughly cleaned and gas freed to hot work standard.
It is not permitted to perform hot work in a dedicated slop tank, unless the vessel is in dry dock.
The tank should be inerted.
The tank should be pre-washed to remove the majority of residues.

Where portable lights are required to adequately illuminate a hot work site, how should they be used? 
They should be clamped or otherwise secured in position, not hand-held, with leads kept clear of the working area.
They should be held by the assistant at a safe distance from the hot work, with leads kept clear of the working area.
Additional illumination from portable lights is not required; there is enough light from the hot work activity itself.
They should be suspended by natural fibre rope at a minimum distance of 2.5 metres from the hot work activity.

Who is responsible for ensuring that adequate arrangements are provided for contractors or work gangs, temporarily employed on board, to understand and comply with all relevant safe working practices?
The Master.
The Superintendent.
The Contractor.
The Shore supervisor.

When a ship is in dry-dock, which of the following primarily governs the management of all safety matters? 
The shipyard SMS.
The shipboard SMS.
The Port Authority Safety Regulations. 
SOLAS.
The national regulations of the country in which the dry-dock is located. 


The ship is to carry out some steel replacement in and around the forecastle head, following storm damage. Shoreside contractors are to be brought on board for the hot work. Why must the Risk Assessment for the intended work take special account of these contractors?
Because they will be exposed to hazards not normally encountered on shore and they may have little or no maritime experience.
Because port regulations require that any Risk Assessment requires contractors to be specifically noted.
Because SOLAS 1974 requires that special provision be made for shoreside contractors working on board vessels afloat.
Because such workers are classified as “high risk” under the port regulations.
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What is the first step in any potentially hazardous work task on board:
Risk assessment.
Filling out the permits to work.
Taking equipment required for the job into the space.
A planning meeting to discuss how to carry out the repair.
Reporting.

What is the principal hazard associated with entry into an enclosed or confined space?
The potentially hazardous atmosphere inside.
The possible loss of communication with those outside the space.
Unsafe access arrangements that could lead to a slip, trip or fall.
The Responsible Officer’s signature missing from the entry permit.

Which of the following is an acceptable definition of a dangerous enclosed or confined space”?
One where the atmosphere contains, or may contain toxic or flammable gases or vapours, or other hazardous substances, or be deficient in oxygen, to the extent that it may endanger the life or health of any person entering that space.
A space or void enclosed by bulkheads and an overhead which, by its design and limited number of access points, reduces the hazard exposure of any person entering, or working within that space.
A space with limited access, subject to controlled ventilation, which is well-illuminated, routinely and regularly entered and for which a permit to work has to be issued according to the Safety Management System.

Which of the following is the definition of a gas free compartment?
One that is in a suitable and safe condition, such that sufficient fresh air has been introduced into it to lower the level of any flammable, toxic or inert gas to that required for a specified purpose.
One that is listed on a permit which confirms that the atmosphere contained therein has flammability, toxicity and oxygen readings above the corresponding minimum recommended levels listed in the Safety Management System.
One that is believed to be in an acceptable condition suitable for an intended task, based on the visual inspection by a designated responsible person.
One which the Chief Officer has verbally confirmed to be safe for entry based on his experience and knowledge.

Which of the following describes the “Responsible Officer”?
A person appointed by the employer or to whom the Master of the ship has delegated responsibility, empowered to take charge of a specific task.
A Junior Officer appointed by the Safety Officer to report all activity related to a specific task within an enclosed or confined space, having the required understanding and knowledge for that purpose.
A Superintendent appointed by the company to oversee all safety-related activities on board the ship, capable of delivering specialised training and empowering him to report information relating to enclosed or confined space entry to the management office.
A Senior Officer, appointed by the Master, who can further delegate responsibility for enclosed or confined space entry to a selected Junior Officer or Rating.

In relation to entry into an enclosed or confined space, what is “approved equipment”?
Equipment of a design tested and approved by an appropriate authority for use in a specified hazardous environment.
Filter masks and replacement cartridges issued directly by the Chief Officer.
Monitors and gas test equipment that have been examined and tested within the previous three months.
Apparatus that has been supplied by an approved safety company.

A forecastle store containing paint and chemicals is normally continuously ventilated but the area has suffered an electrical failure and the ventilation fan has been stopped overnight. How would you now consider that storeroom?
As dangerous. It must be treated as an enclosed space for the purpose of entry procedures.
It should be alright for entry but the door should be left open for a few minutes before anyone enters.
There is no problem. It is only a storeroom and has been regularly used up until last night.
So long as the electrical fault has been corrected, it will be OK to enter without additional precautions.

You are engaged in cleaning out an oil sludge storage tank that has been previously tested and approved for unprotected entry and for which a valid enclosed space entry permit exists. While you are working, you begin to smell cargo vapours. Which of the procedures listed below should be followed? (Select all applicable answers).
Immediately exit the tank.
The appropriate tag should be placed on the access prohibiting further entry.
The Responsible Officer should be notified.
The enclosed space entry permit should be cancelled.
Further tests should be made.
The watchman should be sent to get the Duty Engineer.
All personnel in the space should put on filter masks and continue working.
All personnel inside should exit and take a short break while the vapours are dispersed.
An additional portable ventilation fan should be connected.

What is the normal oxygen content in fresh air?
20.9%
16.7%
17.5%
18.2%
22.6%
23%





Which of the following are standard procedures to observe prior to entry into a dangerous enclosed or confined space? (Select all applicable answers)
A Competent Person makes an assessment of the space.
A Responsible Officer is appointed to take charge.
The potential hazards are identified.
The space is secured for entry.
The atmosphere is tested.
An entry permit is issued.
Appropriate safety and operational procedures are put in place.
The senior rating enters the space first, to carry out a preliminary visual inspection before any work starts.
All tags are removed, thus indicating that there is no restriction on entry.

You are in charge of a team that must enter a dangerous confined space to rescue a man who has collapsed inside. What is your main priority?
To ensure that adequate precautions have been taken to protect the rescue team, thereby preventing additional casualties.
To get to the casualty as soon as possible and evacuate him to fresh air, even if it means entering without full safety equipment.
To ensure an assistant records all times and other details for the purposes of completing the report required under the Safety Management System.
To collect and prepare an appropriate range of safety equipment at the entrance to the space, so that whatever is needed can be passed inside without further delay.

In the context of this training module, a “Responsible Officer” is…?
… a person appointed by the Master, or by the company, to take charge of an operation, such as entry into an enclosed or confined space.
… a person possessing sufficient theoretical knowledge and practical experience of the hazards that might be encountered in a planned task, in order to be able to assess their likelihood and potential impact and to define the precautions that will be necessary.
… a Junior Officer who is appointed as a deputy Safety Officer

Some cargoes are “carcinogenic”. What does this mean?
They can generate cancer.
They can induce indigestion and nausea.
They will cause 2nd degree burns.
They may cause permanent blindness.
They will trigger an allergic reaction to inorganic cargo vapours.

A tank that contained a cargo of vegetable oil has been rough-washed with salt water. It has then been allowed to lie untouched for two days. Which of the following toxic substances is likely to have been released into the atmosphere within the tank over this period?
Hydrogen sulphide.
Nitrous oxide.
Ferrous oxide.
Nitrogen dioxide.

If a small crack on a bracket in the middle of a bulkhead between two tanks is to be welded, what atmosphere tests should be performed prior to commencement of the work? (Select all applicable answers)
The atmosphere in the tank to be entered should be tested for flammability and oxygen content.
The atmospheres in the adjacent spaces should be tested for flammability and oxygen content.
The atmosphere in all cargo spaces should be tested for oxygen content.
The atmosphere in all empty ballast tanks should be tested for flammability and oxygen content.

A crew-member is to be sent into an enclosed space to remove remaining sludge deposits from between the frames and fumes are known to be present. Which of the following would be considered a safe procedure for him to follow? (Select all applicable answers)
Using a self-contained breathing apparatus.
Using an externally-generated air supply.
Wearing a filter mask.
If a mechanical fan is running, he needs do nothing special – the atmosphere should be safe enough to breathe naturally.

When is an enclosed or confined space considered safe and fit for unprotected entry?
Only when it has been tested and certified as “gas free” by a competent person and approved for entry.
When cleaning has finished and the compartment has been rinsed with fresh water.
When it smells OK from the deck hatch.
When somebody else has already gone inside without a gas mask.

In safety terms, why might you suspend cargo operations that involve spaces adjacent to a tank intended for entry? (Select all applicable answers)
Because a valve on common piping might be opened in error, flooding the entered compartment.
Because poisonous fumes expelled from those spaces might be drawn in by mechanical ventilators on the entered space.
Because the charter party contract allows for such interruptions without penalty to the shipowner.
Because safety regulations require all operations personnel to assist in any enclosed space entry procedure.

The term “lock out and tag out” is applied to which of the following:
The securing and labelling of equipment against inadvertent use.
Restrictions on personnel against entering certain compartments and spaces on the vessel without the appropriate personal security tag.
The removal of locking devices and withdrawal of advisory notices from valves and switches that had earlier been secured against inadvertent use during an enclosed space entry operation.
The part of a risk analysis where the Competent Person identifies the valves and switches to be secured by placing a red tag on them.
Drag and drop the measured item onto the appropriate meter.
Oxygen analyser - O2
Combustible gas detector - % LFL
Gas detection tubes with pump - Traces of toxic gas
What is the minimum steady reading that must be obtained on an oxygen analyser before unprotected entry into an enclosed space is permitted? (As per general industry standards)
21%
17.5%
22.5%
25%
16%

Can an explosimeter detect the presence of a flammable vapour in a space filled with inert gas? (Select the most correct answer)
Yes.
No.
Many models cannot do so, but some do have an additional fitting which allows it to be used under such conditions.

Can a combustible gas detector be used to detect a gas other than the standard gas on which it is calibrated? (Select the most correct answer)
Yes.
No.
Yes, but only for a limited range of similar gases and reference must be made to the calibration curves supplied with the meter.
Yes, but the operator should be aware that toxic gases with a vapour density of greater than 1.2 may produce erroneous readings.

Which of the following is a correct statement?
Personal monitors only provide a warning against oxygen deficiency and hydrocarbon concentrations when there is a change in conditions in the immediate vicinity of the wearer.
Personal monitors provide a warning against oxygen deficiency and hydrocarbon concentrations throughout an enclosed or confined space in which the wearer is working.
Personal monitors are an acceptable alternative to a remote analyser in determining if an enclosed or confined space is safe to enter in an unprotected condition.
Personal monitors are now replacing remote reading meters as the standard equipment for determining the oxygen deficiency and hydrocarbon concentration within the atmospheres contained in enclosed spaces prior to entry.

Who is permitted to test the atmosphere in an enclosed or confined space for the purposes of authorising entry?
Only a person trained in the use of the equipment and listed as an Approved Operator.
Anyone who can operate the test equipment and is available at the time entry is required.
Only Deck Officers
Only the person who will be entering the space first.

Cargo tank 3 centre has been cleaned and is scheduled for inspection and mopping. You are the Responsible Officer. When will you test the atmosphere in the tank? (Select all applicable answers)
Before anyone enters the space.
At regular and frequent intervals whilst entry continues.
Once every two to three hours during the validity period of the entry permit.
Upon completion of the inspection and as the team exits from the tank.






You are to test the atmosphere in a tank prior to entry. If at all, how will you adjust the ventilation?
I will stop it about 10 minutes before testing and not re-start it until testing is complete.
I will have it running at as close to full pressure as possible throughout testing.
I will reduce it to minimum around 30 minutes before testing and only speed it up again once testing is complete.
I will close over all the lids and secure the ventilator or pressure/vacuum valve closed, so as to create an overpressure within the space.
I will just test it as I find it, without touching any ventilation that is running.

You are to test the atmosphere in a tank prior to entry for cleaning and maintenance purposes. Where will you take the readings?
At multiple levels and in different sections of the space, through the various lids and vents, to increase the possibility of detecting pockets of gas that might remain in less well ventilated areas.
At the bottom of the space, immediately below the access hatch, because toxic vapours are all heavier than air and will sink to the bottom and this is the most likely location for registering any dangerous readings.
At the top of the space, immediately inside the access hatch, because toxic vapours are all lighter than air and will rise to the top and this is the most likely location for registering any dangerous readings.

Whose overall duty is it, to ensure that the plan for entry into an enclosed or confined space is followed?
The Responsible Officer.
The Watchman.
The 2nd Engineer.
The Competent Person
The person in charge of the team that will enter the space

A small cleaning and repair job is to be done in the after peak tank. The tank is heavily framed, of an awkward shape, with several distinct sections and built over and around a number of other storage tanks. Access lids and ventilation pipes are all at the forward end of the tank. You have been appointed to make the risk assessment and be responsible for the subsequent entry and repair. How will you ensure the conditions in the area of the repair are fully checked?
I would assess and plan for an initial entry, carry out further assessment within the space and then plan the entry for the repair on the basis of the additional information obtained.
I would assess and plan as far as possible and then brief those entering the space for the repair to use their judgement when they get to the after end of the tank.
I would enter the tank and take a quick look round to get an overall picture of the general conditions inside the space and plan the subsequent entry and repair job on that basis.
I would look back in the records and find a report from a similar repair in the past. If it was more-or-less the same situation, I would base my planning on that.

You are the Responsible Officer for a maintenance inspection in a ship’s side ballast tank. The after access manhole has been removed but the compartment is still very dark. How might you safely improve the situation? (Select all applicable answers)
Remove additional manhole covers and lids.
Install temporary lighting.
Issue flashlights.
Switch off lighting in other areas.
Issue a flare for the entry team to place and light in the bottom of the space.
Tell the team leader to strike a match if he cannot see too well.


You are assigned as the watchman at the entrance to 3 starboard double bottom ballast tank, inside which the Chief Officer and Cadet are carrying out an inspection. What do you understand you are permitted to do?
I cannot be assigned to other duties while I am watchman and must remain at the entrance to the space while it is occupied.
I must stay at the entrance until it is time for lunch.
I was working in the starboard lifeboat before the Chief Officer called me for the watchman’s duty. If the 3rd Officer tells me to go back to the starboard lifeboat, then I should go, because that was my original job for the day.
Provided I have radio contact with the Cadet inside the tank, it is alright to leave the entrance and carry on working elsewhere on the deck.

You are to be part of a two-man team to enter an enclosed lower deck in the forecastle head. You are to wear self-contained breathing apparatus and the Responsible officer has decided that a lifeline is to be used. What must you ensure you can do with that lifeline?
That I can easily detach it, if it becomes tangled on the steps or other fittings in the forecastle.
I should estimate the distance that the team is to enter the space and ensure that we carry twice that amount of line in with us, so that if it becomes tangled at the bottom, we can still get back to the entrance.
I should check the label on the lifeline to ensure that the breaking strain is adequate to support the weight of my colleague, together with the breathing apparatus and other equipment he is wearing.
I should verify that the colour coding on the end of the lifeline conforms to the requirements of the company Safety Management System, indicating that it is suitable for use in a storeroom area.

You are to enter an enclosed space as part of a small team to undertake some cleaning. How will you ensure that the operation continues in a safe manner?
All of us entering the space, as well as the watchman at the entrance, must remain alert and watch for any changes in circumstances that may render the space unsafe.
We must check the Enclosed Space Entry permit to see that the Responsible Officer has approved the space for a long enough period of time to allow us to complete the cleaning.
We should talk to each other the whole time, so that we will always know that everyone is OK.
One team member should be assigned to perform watchman duties immediately inside the space.

A crew member doing some cleaning in the bottom a cargo tank reports smelling fumes. What should now happen? (Select all applicable answers)
The work should be stopped and everyone should leave the space immediately.
The safety of the situation should be re-assessed.
Permits should be withdrawn and only re-issued with any appropriate revisions.
Any additional controls deemed necessary by the Responsible Officer should be put in place before work resumes.
The crew member should be issued with a filter mask and instructed to continue with the cleaning.
The Responsible Officer should immediately enter the tank to check the situation for himself.



You are the designated watchman at the top of a tank. Three crew members are inside overhauling a faulty pump. You see one man collapse and hear the other two shouting. What are you going to do?
I will sound the alarm immediately, report the situation to the Responsible Officer and assist the rescue team once they have arrived.
I will immediately put a breathing apparatus on and go inside the space and see if I can help the collapsed man.
I will go inside and pull the collapsed man out, because getting him into fresh air quickly could be critical.
I will sound the alarm, then enter the enclosed space and supervise preparations to evacuate the casualty, because the rescue team will bring the stretcher as soon as they are assembled.
I will immediately run to the bridge, raise the alarm and then wait there until the Master arrives to take charge.

You are the watchman at the entrance to an enclosed cargo hold. Why must you “tally”, or check the crew off as they exit the space after finishing their work inside?
To see if anyone is missing and therefore still inside the space.
To record the names for the Chief Officer’s work records and overtime sheets.
Because the Chief Officer’s instructions always list that as one of the duties of the watchman.
Because the watchman is responsible for all the equipment inside the hold and I need to know the number of flashlights, personal meters and safety helmets that have been used.
Because the watchman is the responsible person for a hold entry and should check his squad are all present and correct before he dismisses them.

You are the Responsible Officer for a cleaning job in a cargo tank. Why must you check around inside the space once cleaning is completed?
To check that no rags, flashlights, lines, clothing or other equipment has been left inside, where it could later be drawn into a pump or valve and damage or block it with serious consequences.
Because I have to make sure that all small gear that has been used in the operation is returned to the locker.
Because if anything like that is found during tank or hold inspection, the surveyor might report it.

Place the following steps in the correct sequence, to indicate how a risk assessment is carried out. Drag and drop the steps onto the numbers:
1 Identify the hazards
2 Assess the risks
3 Apply controls"
4 Document the findings
5 Monitor and adjust

You are to assist in “securing” a cargo tank after a cleaning squad have been inside. All personnel and small gear are accounted for and the space is not to be re-entered. Another crew member is returning the safety and working equipment to storage and the Responsible Officer is taking care of notifications, documentation and the removal of isolation-tags and notices in the control room. What should you do at or near the tank itself? (Select all applicable answers)
Remove green “safe to enter” tag
Stop the ventilation fan
Withdraw lines and hoses, etc
Close the lids
Start pump
If the atmosphere in a compartment is considered to be suspect or unsafe, then it should only be entered for which of the following purposes? (Select all applicable answers)
If it is essential for testing purposes, that being not possible from a remote location.
For the safety of life, or of the ship.
For the work of the ship under controlled conditions.
For regular cleaning and maintenance under uncontrolled conditions.
If it is the fastest and most convenient way to prepare the space for cargo.

You are assisting outside an enclosed space. A maintenance crew are inside and are using air-line breathing apparatus, supplied from a compressor located on deck close to the manhole cover access. The compressor has an emergency supply in a cylinder connected via a manifold. The compressor suddenly stops. You switch over to the emergency supply straight away, but what should the team inside the space do?
They should immediately stop work and exit the space.
They should finish their assigned work as quickly as possible.
Each man inside should take a deep breath, remove his face mask and make his way to the exit.
They should check the local pressure gauge and estimate how much longer they can remain inside the space.

You are the watchman at the entrance hatch to a tank where three men, wearing self-contained breathing apparatus, are working inside. You hear the low level audible alarm whistle from one of the sets. What are you going to do?
Look for the user moving immediately towards the exit and assist him once he emerges.
Immediately sound the emergency alarm.
Try and establish which set it is that is sounding the alarm, by shouting to, or otherwise communicating with, those inside.
Take another fully-charged set inside for the user.
Lower a full cylinder into the space for the user and wait to pull the empty one out, so it can be re-charged

What are the employer’s legal obligations in respect of the provision of training on entry into dangerous enclosed or confined spaces?
He must provide the necessary training, instruction and information to employees, in order to ensure that the regulations pertaining to entry into dangerous enclosed and confined spaces are complied with.
He must provide training, instruction and information on entry into dangerous enclosed and confined spaces only if a request comes from the Safety Committee of a ship through the Master.
He must provide general safety manuals, CD’s and videos that could include some basic guidelines on entry into enclosed spaces.
The Employer is not actually legally required to provide any training at all.

Drag and drop the phrases below, re-arranging them to complete safety training bullet points used in lessons relating to enclosed space entry.
If in doubt - stay out!
The greatest risk inside the space - is from its atmosphere
Look after the equipment; you never know - when you will need it
Poor planning leads to - poor performance.
Don’t take short-cuts. - check and check again
You are the Responsible Officer for a tank entry operation, where the seamen working inside are being supplied with air from a compressor in the machinery space. Who will you advise of this arrangement and why?
The Engineer on Watch.
The Officer on Watch on the bridge.
The Master.
So that those in charge of the equipment understand its current purpose and do not shut the compressor down until the work is completed.
So that the running hours on the compressor can be noted.
So that the outlet delivery pressure to deck can be reduced to the combined breathing rate of the seamen in the tank.

Breathing apparatus should be inspected and tested periodically, as per the company maintenance schedule. When else should it be tested for correct operation?
Before and after use.
After leaving port.
2-4 days prior to arrival in port.
When it has been in use in an enclosed or confined space for more than 1 hour.
When it has been in use for any routine or emergency task where it may have been submerged in water or exposed to water spray.

You are the Master of a vessel which normally has a minimum safe complement of four personal oxygen monitors. Two are to be sent ashore for service in the next port but there is a programme of ballast tank inspections scheduled in that port. What could you do to ensure that the ship’s personnel continue to be work under safe conditions? (Select all applicable answers)
I could arrange temporary replacements until the ship’s monitors are returned.
I could reduce the schedule of entry operations, so that any personnel going inside have the use of the remaining monitors.
I understand that inspection of the ship is paramount and will issue instructions that the remaining meters should be continually transferred between tanks to enable at least some checking of the atmospheres where personnel are working inside the enclosed spaces.
I must stop enclosed space entry altogether as two monitors is not legally enough.
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File, Edit, View, Insert, Format, Tools, Window, Help are command groups that are displayed on the: 
Standard Toolbar
Formatting Toolbar
Menu Toolbar
Drawing Toolbar

There are two ways of exiting MS Word:
Clicking the lower ‘X’ icon on the top-right corner of the Window screen 
Clicking the upper ‘X’ icon on the top-right corner of the Window screen
Clicking File > Close from the Menu Bar
Clicking Edit > Go To from the Menu Bar

You can use the Save As command to: (Check all correct options)
Change the formatting of the file
Rename a document as a back-up copy
Change the font style of a document
Save a file in another folder

True or False: To view the hidden commands, you can click the double-headed arrow at the bottom of the Menu List.
True
False

True or False: To preview a document before printing you can click the magnifying glass, which is the Preview icon.
True
False

Which command is associated with this icon?
[image: E:\222\142\word\pic\Q4_4_6.jpg]
Open New File.
Print File.
Save File.
Which command is associated with this icon?
[image: E:\222\142\word\pic\Q4_4_7.jpg]
Open New File.
Print File.
Save File.
Print Preview File.


Match the following:
Reach the start of line - Home
Reach the end of the document – Ctrl+End
Skip and reach certain words – Ctrl+right or left arrow keys
Reach the start of the document – Ctrl+Home
Reach the end of the line  - End

Match the Keyboard shortcuts with their Functions by dragging and dropping the shortcut commands on the functions.
Ctrl+V - Paste
Ctrl+X - Cut
Ctrl+Z - Undo
Ctrl+C - Copy

Which command is associated with this icon?
[image: E:\222\142\word\pic\Q5_4_3.jpg]
Undo Last Action.
Redo Last Action.
Paste Text.
Copy Text.



Which command is associated with this icon? 
[image: E:\222\142\word\pic\Q5_4_4.jpg]
Undo Last Action.
Cut Text.
Paste Text.
Copy Text.

To select a single word in the document: 
Single click the word.
Double-click the word. 
Click in the margin.
Right click on the word.

To copy the formatting style of a selected line to another text: 
Use Format Painter Icon
Use Copy Icon
Click Format > Copy
Click Edit > Paste Special

To format text as shown above, which font effect is used? 

[image: E:\222\142\word\pic\Q5_4_7.jpg]
Strikethrough 
Subscript
Superscript
Bold 



What are the font formatting characteristics like bold, italics, and underline are called? 

Fonts 
Font styles 
Font effects
Font feature

What is the command to choose a Language Dictionary to be used for checking text?
Click Tools > Spelling and Grammar. 
Click Tools > Track Changes.
Click Tools > Set Language.
Click Tools > AutoCorrect.

What is the feature in Word that recognises and checks spelling, typing errors, and grammar mistakes called?
AutoFormat
AutoLayout
AutoShapes
AutoCorrect

The Find command is located in which menu?
File > Find…
Insert > Find…
Edit > Find…
Format > Find …

How is an inserted comment in the text document shown?
A Coloured highlight 
A small red triangle on the word 
Bold font
Italic font

You can use the AutoCorrect feature in a document to correct which type of mistakes?(Check all correct options)
Correct two INitial CApitals
Clear all comments
Capitalise names of days
Cancel mathematical functions

True or False: You can set the Paper Size by Clicking File > Page Setup to open the dialog box.
True
False

True or False: You can set the number of copies by Clicking File > Print to open the dialog box?
True
False

Which command is associated with this icon?
[image: E:\222\142\word\pic\Q7_3_3.jpg]
Print.
Print Preview.
Save.
Copy Text.

What is the command to set the Margins of a document?
File > Page Setup
File > Properties
Edit > Select All
Insert > Break

What is the default orientation for the printed page?
Portrait 
Landscape 
The last saved action 
Vertical

What is the correct sequence of commands to add a Page Header or Page Footer?
View > Header and Footer
Insert > Cells
Insert > Comment
View > Page Break Preview

What is the correct option to Print a particular page from the active worksheet?
Select ‘All’
Select ‘Current Page’
Select ‘Pages’
Select ‘Selection’

What is the correct command to insert a table in a document? 
Table > Insert > Table
Table > Autofit
Insert > Table 
Insert > Index and Tables

What is the command to convert an existing text to a table? 
Click Table > Convert > Text to Table. 
Select Insert > Picture > AutoShapes.
Click Table > Insert > Text.
Click View > Toolbars > Tables and Borders.

Different styles of format options such as colour and font that can be applied quickly to a Table is known as:
AutoCorrect
AutoShapes
Clip Art
AutoFormat

What is the correct command to colour a selected Table row?
[image: E:\222\142\word\pic\Q8_4_4.jpg]
Table Properties > Row
Table Properties > Cell
Table Properties > Table > Border and Shading > Shading
Table Properties > Table > Border and Shading > Border

What is the correct command to split selected cell? 
[image: E:\222\142\word\pic\Q8_4_5.jpg]
Table > Table Properties > Cell
Table > Split Cells
Table > Merge Cell
Table > Split Table











What type of List is shown in the picture?
[image: E:\222\142\word\pic\Q8_4_6.jpg]
Bulleted
Numerical
Nested or Outlined
Alphabetical

What type of List is shown in the picture?
[image: E:\222\142\word\pic\Q8_4_7.jpg]
Bulleted
Numerical
Nested or Outlined
Alphabetical

Which is the correct command to create a List as shown in the picture?
[image: E:\222\142\word\pic\Q8_4_8.jpg]
Format > Bulleted and Numbering > Bulleted.
Format > Border and Shading
Format > Bulleted & Numbering > Nested or Outlined
Format > Fonts
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Where in the IMDG Code would you find the IMO/ILO/UN ECE guidelines for the packing of Cargo Transport Units?
The Supplement
Volume 1: Part 4
Volume 1: Part 6
Volume 2, chapter 3.2
Volume 1: Appendix 4

A fibreboard package containing 4 metal cans of Caesium Nitrate, individual weight 1kg each, transported under the provisions of chapter 3.4 of the Code, will bear which of the following markings? 
A
B
C
D
E

A cargo transport unit contains 50 drums, each with the UN number 2967 displayed on it. Which number should be displayed in the lower half of the diamond on the placard on the front, rear and both sides of the unit? 
8
2967
50
3

What medical warnings are found in the Dangerous Goods List for 3-TRIFLUOROMETHYLANILINE?
Toxic if swallowed, by skin contact or by inhalation.
Corrosive if swallowed.
Causes burns to skin, eyes and mucous membranes.
Poisonous.
High rate of skin decomposition on prolonged contact.

(This question does not include the exception whereby dangerous goods are being stowed “away from” each other and with the approval of the competent authority) In relation to packing dangerous goods in a single cargo transport unit, the term “segregated from” means:
Not allowed in the same cargo transport unit.
Not permitted on the same vessel.
Must be stowed on deck.
Must be separated by at least 3 metres horizontally.





Which of the following types of packaging are covered by the general term “Cargo Transport Unit”? (Select all applicable answers)
Road freight vehicles.
Railway freight wagons.
Freight containers.
Road tank vehicles.
Railway tank wagons.
Portable tanks.
Large packagings.
Military personnel vehicles.

A marking label coloured green will refer to dangerous goods of which class? 
Non-flammable, non-toxic gases.
Flammable gases.
Flammable solids.
Toxic substances.
Those for accelerated customs processing.
Those with the UN Environmental Committee approval.

Packages of UN 2861 and UN 1120 are intended for transport by sea. Which of the following applies?
No specific segregation is required. 
Must be stowed away from each other.
Must be separated from each other.
Must be separated by a complete compartment or hold from each other.
Must be separated longitudinally by an intervening complete compartment or hold from each other. 

When a Cargo Transport Unit is loaded with a mixture of dangerous goods and non-hazardous materials, how should the dangerous goods consignments be loaded?
Wherever possible, adjacent to the doors, with labels and markings visible.
On the bottom of the unit, to ensure no damage of other cargo occurs in the event of leakage.
Away from all doors or openings to prevent falling out when the unit is opened.
On top of the non-hazardous material, so as to be readily accessible for priority unloading.

Where do you find a list of substances by segregation group and UN number?
Volume 2, chapter 3.1.
Volume 1, chapter 3.1.
Volume 2, Appendix A.
The Supplement, Appendix 1.
Volume 2, Index.



According to the IMDG Code, a freight container which is loaded with dangerous goods and which is intended for transport by sea, must display the placards as described by which of the following statements?
On each side and on each end of the container.
On each side and on the back end of the container.
On each side only.
On the back end only.
On each side, each end and transversely in the middle of the top of the container. 

Unless otherwise provided in the Code, marking of a package containing dangerous goods of UN Number 2196 should be:
TUNGSTEN HEXAFLUORIDE UN 2196
TUNGSTEN GASES
TUNGSTEN HEXAFLUORIDE
UN 2196
TUNGSTEN HEXAFLUORIDE CLASS 8

Which of the following are contained in the Supplement to the IMDG Code? (Select all applicable answers)
Emergency Response Procedures for Ships carrying Dangerous Goods.
The Medical First Aid Guide for Use in Accidents involving Dangerous Goods. 
The International Code for the Safe Carriage of Packaged Irradiated Nuclear Fuel, Plutonium and High-level Radioactive Wastes on board Ships.
The Dangerous Goods List.
The List of Generic and N.O.S. Proper Shipping Names.

“A Shipping Declaration is not required to be provided by the consignor when shipping a package marked “Dangerous Goods of Class 3– Limited Quantity”. Which of the following is a correct assessment of this statement?
False.
True.
True only when the total quantity does not exceed 5 litres.
True, only when contained in aerosols of not more than 1000 square centimetres, contained within an inner packaging.

What material would a drum, the marking on which began with [image: ] be constructed from?
Plastics.
Steel.
Aluminium.
Metal, other than steel or aluminium.
Fibre.



Which of the following is used to denote a Marine Pollutant in the Dangerous Goods List?
P
MP
P(M)
PP
MarPol
SMP

To what source of safety information would you refer in the case of a spillage of a substance identified with the UN number 1230?
EmS schedule S-D.
EmS schedule F-E.
MFAG Table 16.
Dangerous Goods List, column 16.
IMDG Code, chapter 7.2, table 16.

To what source of safety information would you refer in the case of a fire involving a substance identified with the UN number 2257?
EmS schedule F-G.
EmS schedule S-N.
MFAG Table 17.
Dangerous Goods List, column 12.
IMDG Code, chapter 7.2, table 4.

What does the Code say about the transportation of CHLOROPRENE, STABILIZED as a “limited quantity” under the provisions of chapter 3.4?
The entry in column 7(a) of the Dangerous Goods List is “0” and therefore indicates that this substance cannot be transported as a limited quantity shipment.
The entry in column 7(b) of the Dangerous Goods List is “none” and therefore indicates that there is no restriction on this substance being transported as a limited quantity shipment.
The entry in column 16 of the Dangerous Goods List indicates that the substance should be stowed clear of living quarters. A limited quantity can therefore be carried, provided it is stowed more than 24 metres away from the accommodation. 
The entry in column 8 of the Dangerous Goods List refers the user to a Packing Instruction, which explains how the substance may be transported under “Limited Quantity” requirements.`

What special packing provisions would apply to an IBC, of construction code 11A, used for the transportation of OSMIUM TETROXIDE? 
Such an IBC shall be carried in a closed cargo transport unit or in a freight container or vehicle, which shall have rigid sides or fences at least to the height of the IBC.
Such an IBC shall be sift-proof and water-resistant or shall be fitted with a sift-proof or water-resistant liner.
Such an IBC shall meet the performance group II performance level. 
IBCs shall not be used for the transportation of this substance.

What provisions apply in respect of dangerous goods in limited quantities that are packed and distributed in a form for sale through retail agencies for personal or household use? (Select all applicable answers).
They do not need to be labelled.
They do not need to bear a marine pollutant mark.
They do not need to be marked with the Proper Shipping Name.
They do not need to be marked with the UN number.

How would you expect to find a package that previously contained a consignment of UN Number 2067 marked? It is in an uncleaned condition and there are still heavy residual vapours inside the package.
AMMONIUM NITRATE BASED FERTILIZER UN 2067
Empty packages are not required to be marked.
EX UN 2067.
Empty after AMMONIUM NITRATE.
Empty after UN 2067.

What are the Proper Shipping Name and UN Number for the substance Bromomethane?
METHYL BROMIDE with not more than 2.0% chloropicrin UN 1062.
BROMOCHLOROMETHANE UN 1887.
BROMOMETHANE , UN 1062.
BROMODIPHENYLMETHANE, UN 1770
METHYL BROMIDE AND ETHYLENE DIBROMIDE MIXTURE, LIQUID UN 1647

Where in the IMDG Code do you find the provisions relating to Temperature Control?
Chapter 7.7.
Appendix A of the Supplement.
Column 9 of the Dangerous Goods List.
Column 17 of the Dangerous Goods List.
Section 5.3.2.2 “elevated temperature substances”

Drag and drop the substance names to match the correct provisions and descriptions:
Stowage Category A stowage, keep as cool as reasonably practicable. Butyric Acid
Homogeneous mixtures containing not more than 35% by mass and at least 65% of inert substance are not subject to this Code unless criteria of other classes are met. Azodicarbonamide
Flexible IBCs shall be sift-proof and water-resistant or shall be fitted with a sift-proof and water-resistant liner. Magnesium Fluorosilicate
Marine Pollutant; Packing Group 1; Not permitted for transport under Limited Quantity provisions;  Sodium Cyanide Solution
In contact with acid, evolves silane, a spontaneously flammable gas.  Calcium Manganese Silicon
EmS Fire Schedule E, Spillage Schedule D. Phenyl Mercaptan



To which explosives compatibility Class are “Articles containing a secondary detonating explosive substance, without means of initiation, with a propelling charge (other than one containing a flammable liquid or gel or hypergolic liquids) or without a propelling charge” assigned?
E
C
L
B
G

What pressure relief provisions apply to the carriage of TRIETHYLENETETRAMINE in portable tanks?
Normal provisions apply.
Such a tank is required to have an approved relief device constructed of materials compatible with the load.
Such a tank is required to have a relief device comprising a frangible disc preceding a spring-loaded pressure relief device.
Tanks containing this product are not fitted with a pressure relief device.

Where will a dangerous substance, material or article not mentioned specifically by name in the Dangerous Goods List appear?
In the List of generic and N.O.S. Proper Shipping Names.
In the Glossary of Terms.
In Packing Provision P200.
In the List of Class 9 Substances, Materials and Articles.

Which of the following is a description of a gas?
Having a very low density and a very low viscosity when compared to the other states of matter; will readily expand under applied heat or pressure; easily compressed.
Matter in its most concentrated form; having a close-packed and regular crystalline structure; can be melted by heat, but may be of a high level.
A non-crystalline form of matter, falling between the solid and liquid states; of definite mass, difficult to compress; no permanent shape and the molecules are free to move within the limits of any container; varying greatly in viscosity, melting point, vapour pressure and surface tension. 

Which of the following is a correct statement?
The hazard posed by a substance can arise from a dangerous reaction of the substance or article with other substances in the surrounding environment.
Substances in the surrounding environment can have no dangerous impact on packaged dangerous goods.
A dangerous reaction between a substance or article and other substances in the surrounding environment is only possible if those goods are packaged in a container constructed of soft and non water-resistant material.




Which of the following shall apply to packagings in direct contact with dangerous goods? (Select all applicable answers)
They shall not be affected or significantly weakened by the dangerous goods.
They shall not cause a dangerous effect in the dangerous goods.
They shall be constructed of non-porous material.
They will absorb a rise in surface temperature of not more than 20°C as a result of such contact.
They will not exhibit any visible distortion directly attributable to such contact.
They will be deliver an equivalent standard of protection to a class 2 (sift-proof and water-resistant) liner.

According to the guidelines in the IMDG Code, what temperature should be used when calculating the maximum volume to be loaded to a tank container be calculated, in order to avoid leakage or distortion resulting from expansion due to temperature change during transport?
50°C.
55°C.
60°C.
100°C.
15.6°C.
38°C.

Which Packing Group is assigned to substances presenting a low level of danger?
Packing Group I.
Packing Group II.
Packing Group III.

Drag and drop the alpha-numeric codes as found in the Dangerous Goods List onto the applicable packing Instructions and Special Packing Provisions:
Packing Instructions for packagings other than IBCs and large packagings. P
Packing Instructions for Intermediate Bulk Containers. IBC
Packing Instructions for large packagings. LP
Special Packing Provisions for packagings other than IBCs and large packagings. PP
Special Packing Provisions for Intermediate Bulk Containers. B
Special Packing Provisions for large packagings. L
[image: ]
Which of these is the UN Packaging Symbol?  
A 
B
C
D







What is salvage packaging?
Special packaging into which damaged, defective, leaking or non-conforming packages or dangerous goods that have spilled or leaked are placed for the purposes of transport for recovery or disposal. 
Packaging used only at the direction of a contracted environmental protection response company. 
Packaging which has been reconditioned after previous use.
Packaging which is manufactured from recycled material.
Packaging in which goods recovered from the sea are held, pending investigation by the appropriate authority.

Which of the following are considered a “Cargo Transport Unit” under the IMDG Code? (Select all applicable answers)
Road freight vehicles.
Railway freight wagons.
Freight containers.
Road tank vehicles.
Railway tank wagons.
Portable tanks.
Military personnel carrying vehicles.
Large plastic barrels of 150 litres or more.

Within the IMDG Code, the term “labelling” refers to which of the following?
Identification of the risks and hazards presented by substances contained in a package.
Identification of the substance contained in a package.
Identification of the risks and hazards presented by substances contained in cargo transport units.

Within the IMDG Code, the term “marking” refers to which of the following?
Identification of the substance contained in a package.
Identification of the risks and hazards presented by substances contained in a package.
Identification of the risks and hazards presented by substances contained in cargo transport units.

A ”Consignee” is which of the following?
Any person, organization or Government that is entitled to take delivery of a consignment.
Any person who prepares a shipment for transport.
A shipment of dangerous goods.
A member of a competent authority charged with the administration of the transportation of dangerous goods.




Proper Shipping Names and UN Numbers are used for which two primary purposes?
To ensure that the substance, material or article can be readily identified during transport, especially in the event of an emergency.
To provide the necessary information for the Master to be able to comply with reporting requirements in the event of a pollution incident.
To complete the additional security documents when entering a port subject to a level “orange” security alert.
To demonstrate compliance with MARPOL 73/78 when subject of a Port State Inspection.

Which of these labels is used to indicate a marine pollutant?
[image: ]


Drag and drop the correct class descriptions onto the applicable classes labels:
Flammable Gases.
Non-flammable, non-toxic gases.
Substances which, on contact with water, emit flammable gases.
Infectious Substances.
Corrosive Substances.
Explosives, division 1.5.
Flammable Solids.
Toxic Substances.
[image: ]



Which of the following details should be included in a manifest of dangerous goods loaded on board a ship? (Select all applicable answers)
The UN Number.
The Proper Shipping Number.
The Class and Division of the goods.
Where assigned, the Packing Group number.
The location within the ship.
The total quantity of dangerous goods within the package.

Where would you stow a package of dangerous goods, subject to the provisions of Stowage Category D, on a cargo ship, of length 81 metres overall, carrying 24 passengers? 
ON DECK ONLY.
Such stowage is PROHIBITED.
Either ON DECK or UNDER DECK.
In a locked cargo compartment.

When related to the “on deck” stowage of packages, which of the following is a definition of the stowage term “away from”?
Effectively segregated so that the incompatible goods cannot interact dangerously in the event of an accident, but may be transported in the same compartment or hold or on deck, provided a horizontal separation, projected vertically, of 3 metres is obtained. 
Either in a vertical or horizontal separation. If the intervening decks are not resistant to fire and liquid, then only in a longitudinal separation is acceptable. For “on deck” stowage, this means a distance of at least 12 metres. This distance also applies to one package stowed “on deck” and another in an upper compartment. 
Vertical separation alone does not meet this requirement. Between a package “under deck” and one “on deck”, a minimum distance of 24 metres, including a complete compartment, must be maintained longitudinally. For “on deck” stowage, this segregation means a minimum distance of at least 24 metres longitudinally. 

Which of the following is a definition of the control temperature of a dangerous substance as applicable to the IMDG Code?
The maximum temperature at which certain substances, such as organic peroxides and self-reactive and related substances can be safely transported during a prolonged period of time. 
The lowest temperature at which decomposition may occur for a substance in a packaging as used in transport. 
The temperature at which emergency procedures shall be implemented.
The temperature at which the goods are discharged.
The overall average temperature drawn from daily observations on passage. 





The Medical First Aid Guide for Use in Accidents Involving Dangerous Goods provides advice intended for which of the following?
The initial management of chemical poisoning and diagnosis within the limits of the facilities available at sea.
The comprehensive and total management of chemical poisoning and diagnosis to full recovery, with assistance from shore as required.
The proper documentation to the flag state authority in the event of a fatality involving dangerous goods on a vessel.
The limited care of casualties in exposure incidents involving liquid chemicals.
The accurate transfer of information relating to a spilled cargo to the appropriate shoreside medical and environmental agencies. 

Drag and drop the appropriate steps to show the three stages in the correct sequence to be used when applying the MFAG:
Sequence 1 - Emergency Action and Diagnostic Diagrams.
Sequence 2 - Tables.
Sequence 3 - Appendices

The classes drawn up by the UN Committee of Experts when writing the IMDG Code were based on which of the following?
The type of hazard they present. 
Alphabetical order.
UN Number.
Laboratory tests of different chemical groups.
The average tonnage of different groups of dangerous substances shipped worldwide in packaged form.
Pre-existing airline rules.

Which of the following symbols would you expect to find on a thermal tank containing liquid of a high temperature?
[image: ]
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Which of these labels would be attached to a package containing explosives?
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CD # 160 52 Fire Fighting (Basic)
Состоит из восьми глав.
1-7 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе. В конце каждой главы есть вопросы, на них надо ОБЯЗАТЕЛЬНО ОТВЕТИТЬ, не важно правильно или нет. 
8 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов. Ответы взяты из обновленной версии теста (cd 160), и несколько вопросов может небыть или они могут быть сформулированны иначе (52). Данных ответов хватит чтобы сдать тест минимум на 90%, чего достаточно для успешного прохождения.























Where can you find an overview of where the powder extinguishers are located? 
In SOLAS. 
IMO. 
The fire control and safety plan.	 
The emergency plan. 

﻿Do we call it "suffocating the fire" when we remove the oxygen from the fire?  
Yes. 
No. 

﻿Does there have to be oxygen present to light a flammable gas? 
No. 
Yes. 
Only with special gasses. 
Only with special fluids. 

﻿What fire extinguisher is most suitable for putting out fires in metal? 
Water. 
Powder. 
CO2. 
Special powder. 

﻿Can National Maritime Authorities and Classification Societies require additions to the SOLAS requirements? 
No, only National Maritime Authorities. 
No, only the Classification Society. 
Yes. 
No. 

﻿Does the Muster list and the Emergency Instructions contain information relevant only to the deck officers? 
Yes. 
No, relevant to all officers. 
No, all crew members and other personnel onboard. 
No, only the crew. 


















﻿In order for there to be a fire, there has to be an unbroken chain reaction between three components.
One of the components is the combustible material.
What do you think are the two other components that have to be present in order to start a fire? 
Oxygen 
CO2 
Halon 
Wood 
Heat 
[image: ]

﻿For most products the fire will die out when the oxygen content is reduced to? 
10%. 
12%. 
15%. 
21%. 

﻿How do we normally remove the heat from a class A fire? 
Use of water or foam. 
Use of CO2 or foam. 
Halon or powder. 
Powder or CO2. 

﻿The temperature at which a product will give sufficient vapour that can be ignited is known as the ……………. point of the material. 
Gas. 
Flammable. 
Ignition. 
Vapour. 
LEL+UEL [image: ]

﻿Which of these materials has the best heat conduction?  
Gas. 
Liquid. 
Metal. 
Wood. 

﻿What does heat radiation mean? 
A process in which the heat is spread from one molecule to another molecule. 
A process in which warm or heated molecules start moving. 
A process of emitting heat waves. 
A process in which heat waves starts a fire where the waves meet. 

﻿CO2 is especially suitable for fighting one or more of the fire categories, which category? 
Class A, Ordinary combustible materials. 
Class B, Oil and other flammable liquids. 
Class C, Gasses. 
Class D, Metal. 

﻿Which fire extinguisher's could you use to put out burning oil? 
C02. 
Dry Powder. 
Water (applied by jet). 
Water (applied by spray). 

﻿A CO2 system extinguishes a fire in a protected space by...  
Cooling down the fire. 
Reacting chemically with the fire. 
Depriving the fire of oxygen. 
Blow out the flames. 

﻿Is this statement true or false?
"Always attempt to extinguish a fire before sounding the alarm". 
False 
True 

﻿A sprinkler system is normally used to protect the ................... 
Engine room. 
Accommodation area. 
Galley ducts. 
Tanks on a chemical tanker. 

﻿............ is listed as a CFC gas, as of January 1st 1994 .......... system is not installed onboard new ships. 
Nitrogen 
Halon 
CO2 
Propane 

﻿Where do you always find operation and maintenance instructions for the extinguishers? 
On the Muster list and Emergency Instructions. 
On the label of the extinguisher. 
Displayed in the cabin. 
In STCW. 

﻿Who is in charge of the operation if there is a fire in accommodation? 
Master. 
Chief Engineer. 
Chief Officer. 
Fire Squad 1. 

﻿Which team/squad has the following duties? Stop requested ventilation, close fire flaps and start emergency fire pump if ordered. 
Fire squad 1. 
Fire squad 3. 
Bridge team. 
Technical squad. 

﻿What kind of work is hot work? 
Dismantling a pump. 
Chipping. 
Grinding. 
Cooking. 

﻿What do you do if you detect a fire? 
Immediate muster at your fire station. 
Activate the alarm and then try to extinguish the fire. 
First try to extinguish the fire and then activate the alarm. 
Report to bridge. 

﻿What information can you find on the fire control plan? 
The location of the fire-fighting appliances. 
How to use the fire-fighting appliances correctly. 
How to respond in case of fire. 
Where the Master can be reached in case of emergency. 
﻿It is important to get familiarised with the emergency exits on board the vessel, at what time should this be done? 
Within a week. 
Immediately after boarding. 
Before boarding. 
When you have some extra time. 

﻿What type of fire detectors is the first to go of in case of a fire? 
Smoke detectors. 
Flame detector. 
Heat detector. 
Gas detector. 

﻿Emergency compressed air breathing escape sets onboard, shall have a duration of service no less then: 
20 minutes. 
15 minutes. 
8 minutes. 
9 minutes. 
 ﻿ 
According to SOLAS the breathing air apparatus that must be onboard shall have sufficient capacity for how many minutes of operation? 
20 minutes
30 minutes.
45 minutes
25 minutes.

Ignition, flammable, flash
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CD # 161(52) Fire Fighting (Advanced)
Состоит из шести глав.
1-5 главы - открываем каждую,  нажимаем NEXT (стрелка вправо), до того пока она не пропадет и не появиться PREVIOUS (стрелка влево) и кнопка MENU. Нажимаем MENU, переходим к следующей главе.
6 глава – тест. Ответы на все вопросы выделенны этим цветом. На один вопрос возможно несколько вариантов ответов.

























1) Who bares the overall responsibility for a fire fighting operation onboard a vessel until help arrives? 
1. The Chief Engineer 
2. The First Officer 
3. The Master 
4. The Local Harbour Master 

2) Which of the following should be installed in areas with a high risk of fire? 
1. A fire locker containing protective clothing. 
2. A PA system.  
3. A fixed extinguishing installation.  
4. A fire pump. 

3) ﻿Which of the following should not be done when fighting a fire? 
1. Cooling down bulkheads. 
2. Opening the ventilation. 
3. Removing gas bottles from the area. 
4. Shutting down electrical power. 

4) It is important that messages to smoke divers are made: 
1. through hand signals in noisy environments. 
2. before they enter the fire zone. 
3. on VHF ch. 06. 
4. short and precise. 

5) What is the first thing that should be done upon detecting a fire? 
1. Send a distress call. 
2. Meet up at your muster station. 
3. Notify the bridge. 
4. Initiate the fixed fire fighting systems. 

6) In the event of a fire involving dangerous goods onboard, where can you find information on the chemical reactions taking place? 
1. On stickers placed on the cargo's container. 
2. In the cargo manifest. 
3. In the hazardous materials catalogue. 
4. On its data card. 

7) Which extinguishing agent must you absolutely not use in the event of a fire involving magnesium? 
1. Powder 
2. Halon 
3. CO2 
4. Water 

8) When discovering an injured person what is the first thing you should check for? 
1. Hazards 
2. Their pulse 
3. Their breathing 
4. For broken bones 

9) Dry distillation can cause which of the following? 
1. Structural failure 
2. Flash burns 
3. Breathing equipment failure 
4. Fire gases 
10) ﻿Which of the following must smoke divers be equipped with? 
1. First Aid kit 
2. UHF radio 
3. Heat measuring monitors 
4. Infra-red viewing equipment  

11) Which of the following will the local authorities take care of? 
1. Requisitioning the necessary resources. 
2. Contacting the company's main office. 
3. Informing the media. 

12) What is the first phase of onboard fire fighting tactics? 
1. Extinguish 
2. Evaluate 
3. Rescue 
4. Alert     

13) ﻿If someone does not report to their mustering station during a fire what should be done? 
1. Conduct a search. 
2. Advise the fire fighting teams to keep an eye out for them but continue extinguishing operations. 
3. Use the PA system to ask them to report to their mustering station. 
4. Find someone to take over their duties at that station. 

14) Who will usually carry out statutory surveys and certifications? 
1. The ships company inspectors. 
2. The ships home port authorities. 
3. The IMO. 
4. The ship's classification society. 

15) What is the safest and most effective way to apply water in a fire fighting operation onboard a vessel? 
1. Fog 
2. Direct spray 
3. Sprinkle 
4. Flooding 

16) ﻿One litre of water equals approximately how many litres of steam or mist? 
1. 1200 
2. 1400 
3. 1700 
4. 1900 

17) What should fire-fighters always be equipped with? 
1. Communications equipment  
2. Reflective metallic suits 
3. Axes 
4. GMDSS 

18) What is the most common cause of engine room fires? 
1. Overload on the engine. 
2. Cigarettes coming in contact with flammable waste. 
3. Faulty electrical equipment. 
4. Oil leaks and hot surfaces. 
19) What kind of fires should be reported? 
1. Any fire involving damage to equipment. 
2. Any fires involving death or injury. 
3. Large fires requiring aid from local authorities. 
4. All types of fires. 

20) In the event of a fire investigation what should the crew do? 
1. Aid in the collection of evidence. 
2. Make sure all equipment that was used is put back in the proper place. 
3. Clean away debris from the site. 
4. Make sure that any problem that could have caused the fire is already fixed. 

21) Why is it important to report fires? 
1. It is needed for insurance claims. 
2. It is required by the IMO. 
3. To prevent future fires. 
4. Local fire authorities involved in the operation require it. 

22) When writing a report, which one of the following questions should be asked when interviewing witnesses? 
1. Were proper routines followed. 
2. Was equipment working properly. 
3. Was the area well maintained. 
4. All above

3

image3.jpeg
Which of the following must smoke divers be equipped with?

UHF radio

Heat measuring monitors

First Aid kit

Infra-red viewing equipment





image4.jpeg
Combine the correct hazard sources signs and name.

Good N o)

LA A& &

Heating [ Chemicals. Vibration





image5.jpeg
Drag the correct work permit to the work situation where you need it.

i ——|

ectial 4 wmm N
i

Working Aloft
Permit

Sl Crafe 1
Alongside
Permit





image6.jpeg




image7.jpeg




image8.jpeg
Miasthesd hghﬁ

Starbord
Side lights

1 B
()

Starn fight 5





image9.jpeg




image10.jpeg
Q) orva 5
()

Q@) orva
(2)

Q) = trior
Vo (6) + Lri

-




image11.jpeg
Headines

Forvard 1N

Bresst

Forvard N

Springs

Aftsprings NN

Aft Brasst

correct match. This one is.




image12.jpeg




image13.jpeg




image14.jpeg
Applications

Please click the illustrations to learn more about the subjects!

S arne Luve Of Appleatons T [ =] =] e [ =





image15.jpeg
N
1O




image16.jpeg
o




image17.jpeg




image18.jpeg




image19.jpeg




image20.jpeg




image21.jpeg




image22.jpeg




image23.jpeg




image24.jpeg




image25.jpeg
icrosoft Word =lolx(

sert Format Tools Table Window Help
§‘nvmv‘9n% -@ 2w -2

@ @ Fovoies- |50 | P -

Which comraand i assaciated with this icor?

1. Openew File
2 Pntfle
3. Save il
4. Print Proviw il

wlolw e

[E— >

[Poe 1 sert T T i @# [y





image26.jpeg
le_Edt View Insert Fgrmet Took Table Window Help

DEES| I o -0 =@ o=

-~ 0B @Q rotes-| e M

Which command s associated with this icca?

Fr il





image27.jpeg
i test - Microsoft Ward R = ]

| Ble Edt View Insert Format Jools Table Window Help
I =T N E
=] @ @ ravores

PICILAR!





image28.jpeg
o x|

=G 3

[Pae1 =1 T P i @i O




image29.jpeg
[ He Edt Vew Inert Fomat Toos Table Window telp |

251,200 C deg, E = MC?




image30.jpeg
icrosoft Word o x|

Ble Edt Vew Insert Format Tooks Table Window belp

=G 3

T P i @i O




image31.jpeg




image32.jpeg




image33.jpeg
A

8




image34.jpeg
o . -
E e >
None "
" I .
e ste | 1esins e P—
Seiont1o | o | Az | 01
vt | 101 i o, | 011





image35.jpeg




image36.jpeg




image37.jpeg
GOTIO




image38.jpeg
[ or-fiamm i gases.

[Ecbstances vhich, on cant . et Fammable gazes.

[ G T





image39.jpeg
DN




image40.jpeg




image41.jpeg
Oxygen

In order for there to be a fire, there
has to be an unbroken chain reaction
between three components.

One of the components is the
combustible material.

Choose the two other components
that have to be present in order to
have a fire.

co2 Wood

Halon

Heat





image42.jpeg
The correct answer is;

Combustion OM: Optimal mixture:
intensity HC gas / At
LEL UEL

X 4

~ %

A 4 3 4 5 6 7 8 ] 10 1
Volume percentage
of gas in air





image43.jpeg
The temperature at which a product will give sufficient vapour that can
be ignited and will continue to support combustion after the
application of an outside source of ignition is known as the ignition
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